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1 Configuration

1.1 Installation Of The MADRIX Software

This tutorial shows you how you can install the MADRIX 5 software.

Date: 09/2019

MADRIX Version: 5.1b (Created with)

System Requirements: Please make sure that your PC meets the system requirements. You can find the

requirements »here

Attention: Do not plug any MADRIX hardware into your computer before you install the MADRIX software!

1

.

Download the MADRIX software from »www.madrix.com or connect the MADRIX USB stick to your PC.

2

.

If you use a MADRIX USB stick, please open the "Windows Explorer" and you will find a USB Flash Drive called

MADRIX. Please perform a double-click on MADRIX_64Bit_Install.exe 

Otherwise, navigate to the download directory where MADRIX is located and double-click on

MADRIX_FULL_INSTALL.exe

3

.

The Select Language dialog of the Installer will be opened. In this dialog you can choose the language

during installation process.

4

.

A Welcome window appears. Click Next > and the License Agreement window appears. Click I Agree

after reading. Otherwise, you cannot install MADRIX.

http://help.madrix.com/m5/html/madrix/index.html?hidd_system_requirements.html
http://www.madrix.com/
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5

.

Now, you can see the Choose Components window.

In this step, you can choose the components you want to install:

§  MADRIX: It is always required to install MADRIX.

§ MADRIX KEY: Driver It is also always required to install the MADRIX KEY Driver

§ MADRIX Interface Driver: It is also always required to install the MADRIX Interface Driver. It includes the

drivers for MADRIX USBone, MADRIX NEO, MADRIX PLEXUS and MADRIX LUNA interfaces.

§ MADRIX KEY Firmware: Installs the latest MADRIX KEY Firmware.

§ Desktop shortcut: Create a shortcut to the MADRIX software on the Windows Desktop.

§ Quick launch shortcut: Creates a shortcut to the MADRIX software in the Windows toolbar.

§ Examples: Installs some Setup examples, including effects, scripts, and color tables for MADRIX.

§ Interface Driver: Choose this option if want use MADRIX software with a supported third-party DMX

interfaces. You don't need this option if you want to use the MADRIX software only with MADRIX interfaces

or you use MADRIX only with DVI output. 

§ WinPcap Driver: Choose this option if you want to control the EuroLite T9 (e.g., LSD screens) or 5A or

CoulorSmart Link.  
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6

.

Now, you can choose the install location.

Click Browse and select your desired destination folder. After that, click Install and the installation process

begins. This will take some minutes. When the installation is complete, click Next >

7

.

1

If you want to work with MADRIX 5 in Demo Mode, you can click Finish and MADRIX 5 will start.
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7

.

2

When installing MADRIX 5 the first time on your PC and you already have a MADRIX 5 KEY, please disable

the Run MADRIX 5.X checkbox and click Finish
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8

.

If you start MADRIX 5 with a connected MADRIX 5 KEY the first time, please make sure that the MADRIX 5

KEY is working with the latest MADRIX KEY firmware. 

Please connect the MADRIX 5 KEY to the PC and wait until the driver of the MADRIX 5 KEY has been installed.

In the next step please start MADRIX 5 and go to Help > MADRIX KEY > Update MADRIX KEY

Firmware.
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9

.

Please wait until the update process is finished.

1

0

.

If the license of the MADRIX KEY was not activated, you will need to activate it first.

In the following tutorial you can learn how the activation works: Activate the MADRIX License.

Congratulations! You have successfully installed MADRIX.
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1.2 Activate MADRIX License

In this tutorial you will learn how you can activate a MADRIX license on a MADRIX KEY.

Date: 10/2018

MADRIX Version: 5.0 (Created with)

Requirements: 

· You will need an empty MADRIX 5 KEY and a MADRIX 5 Online Activation.

· The used PC must be connected with the internet. 

· MADRIX 5 should be installed on the PC. You can learn how to install MADRIX »here.

1

.

Please connect your empty MADRIX 5 KEY to the PC, start MADRIX 5 and go to Help > MADRIX KEY >

Activate MADRIX KEY...

2

.

The default web browser opens with the MADRIX KEY activation service.
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3

.

In this web page you have to copy the ticket number for this KEY. You will find the ticket number in the

MADRIX 5 Online Activation file you got sent from your dealer.

Please open the this PDF File and copy the ticket number.
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4

.

Please paste the ticket number on the Ticket Number filed of the MADRIX KEY activation service in your

web browser and click Next.
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5

.

On the next side of the activation process you will find all available licenses of this ticket. Normally only one

license is assigned to one ticket. To activate the licenses please click Activate Licenses. 
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6

.

In the next step you have to select your desired license and if more than one KEY is connected you have to

assign it to the right MADRIX KEY.

After this please click Activate Selected Licenses Now and the selected license will be transferred to the

MADRIX KEY. This will take a while.
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7

.

After the Online License Transfer was done you will get a message.

When the license transfer was completely successfully, the license is activated on the MADRIX 5 KEY and you

will never need to activate it again. The KEY is also working now if the PC has no internet connection. 

Now you can use this KEY in connection with MADRIX to unlock the output of DMX channels and DVI voxels

according to the license.

Congratulations! You have successfully learned how to activate a MADRIX KEY with the online activation service

in MADRIX 5.

1.3 Patch Fixtures

In the following tutorials you can learn how you can create patches in MADRIX.

Patching is important in MADRIX to display the desired part of the whole effect on the desired fixture. So the

position of the fixture in the MADRIX patch should correspond to the position of the fixture in the real project.

In MADRIX you only have to think about DMX addressing and/or the right DVI assignment in the patch.
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1.3.1 2D Patch With The Matrix Generator For DVI Output

In this tutorial we will create an easy 2D patch with the help of the Matrix Generator for DVI output.

Date: 10/2018

MADRIX Version: 5.0 (Created with)

Corresponding Video Tutorial: »Creating A 2D Patch For DVI Output With The Matrix Generator

Task: 

We have to create a patch for a DVI output. The resolution of the screen is 160 pixels in X and 90 pixels in Y.

1

.

In MADRIX please go to Preferences > Matrix Generator . 

[Keyboard shortcut F2]

https://www.youtube.com/watch?v=1hLukDlHhW0&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=2&t=0s
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2

.

The Matrix Generator opens with the default settings.

The full explanation about all functions of the Matrix Generator you will find in the MADRIX 5 manual

chapter: »Using The Software > Patching > Matrix Generator

http://help.madrix.com/m5/html/madrix/index.html?hidd_matrix_generator.html
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3

.

Now we have to change the settings according to our task, to patch a DVI resolution of 160 x 90 pixels.

· The Protocol must be changed to DVI.

· In this example we create a patch with the Product: !generic RGB Light 1 pixel

· The Count X will be set to 160, the Count Y will be set to 90 and the Count Z we don't change and leave

it at 1

After we change this setting we click OK

[Keyboard shortcut Enter]
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4

.

After the Matrix Generator was closed MADRIX creates the new matrix of 160 x 90 pixels immediately.

Congratulations! You have successfully learned how to create a 2D patch for DVI output with the help of the

Matrix Generator.
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1.3.2 2D Patch With The Matrix Generator For DMX Output

In this tutorial you will learn how to create a patch for a 2D matrix of DMX fixtures.

Date: 10/2018

MADRIX Version: 5.0 (Created with)

Corresponding Video Tutorial: »Creating A 2D Patch For DMX Output With The Matrix Generator

Task: 

We have to create a patch for a 2D matrix of 4x4 pixel panels which are controlled via DMX. The patch consists of

5 fixtures in a row and 4 fixtures per columns. There should be an offset of 2 pixels between every fixture.

All pixel of this panels are RGB pixels and there are no other control channels.

Every row should be assigned to a new DMX universe starting with DMX start channel 1 and universe 1.

The following image shows the DMX address assignment:

https://www.youtube.com/watch?v=qrNHvsTSsyc&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=2
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1

.

Please go in MADRIX to Preferences > Matrix Generator . 

[Keyboard shortcut F2]
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2

.

The Matrix Generator opens with the default settings.

The full explanation about all functions of the Matrix Generator you will find in the MADRIX manual chapter:

»Using The Software > Patching > Matrix Generator

http://help.madrix.com/m5/html/madrix/index.html?hidd_matrix_generator.html
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3

.

Now we have to change the settings according to our task to patch a 4x4 pixel panel in the resolution of 5 x 4

fixtures with an offset of 2 pixels between every fixture.

· In the Fixture section we have to change:

o Normally we don't need to change the Protocol. It must be DMX.

o In this example we create a patch with the Product: !generic Panel 4x4 vertical

· In the Placement section we have to change the following settings:

o The Count X needs to be set to 5, the Count Y needs to be set to 4 and the Count Z we leave at 1

o The offset for X and Y has to be set to 2

· In the Addressing section we need to do the following changes:

o According to the patch plan the first fixture has to be assigned on the top left side. So we change the

Start Corner to Top Right

o Since our task is to have each line patched in a new universe and we know 5 fixtures are in a line we

have to change the Fixture Count Limit Per Universe to 5 

Now we can compare the Addressing Preview with our patch plan. If both are equals, we click OK.

[Keyboard shortcut Enter]



[Part A] Configuration

//25www.madrix.com

MADRIX 5 Tutorials Version 1.0

4

.

After the Matrix Generator was closed MADRIX creates the new matrix of 5 x 4 "!generic Panel 4x4 vertical"

fixtures immediately.
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Congratulations! You have successfully learned how to create a 2D patch for DMX output.

1.3.3 3D Patch With The Matrix Generator

This tutorial shows you how to create a patch for a 3D matrix of DMX fixtures.

Date: 10/2018

MADRIX Version: 5.0 (Created with)

Corresponding Video Tutorial: »Creating A 3D Patch For DMX Output With The Matrix Generator

Task: 

We have to create a patch for a 3D matrix of single pixel RGB fixtures. In this project we have 20 fixtures in X, 16

in Y and 20 in Z installed.

The space between the fixtures in Y is 1 pixel. 

Regarding the DMX address assignment the fixtures are addressed column by column beginning with the front top

left fixture z-layer wise and starts in DMX Universe 1 with DMX Channel number 1.

1

.

In MADRIX, please go to Preferences > Matrix Generator . 

[Keyboard shortcut F2]

https://www.youtube.com/watch?v=AH2RiaahsDk&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=3
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2

.

The Matrix Generator opens with the default settings.

The full explanation about all functions of the Matrix Generator you will find in the MADRIX 5 manual chapter:

»Using The Software > Patching > Matrix Generator

http://help.madrix.com/m5/html/madrix/index.html?hidd_matrix_generator.html
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3

.

In the Matrix Generator we have to change the settings to get the required matrix.

· We don't need to change the Protocol and the Product if we start the Matrix Generator after a restart of

MADRIX

o The Protocol must be DMX.

o We are using the Product: !generic RGB Light 1 pixel

· The settings in the Placement section:

o The Count X has to be set to 20, the Count Y has to be set to 16 and the Count Z must be 20

o The offset for Y have to be set to 1

· In the Addressing section we need to do the following changes:

o According to the task the Start Corner should be Top Left 

o The Main Orientation have to be changed to Vertical

o And the Z-Order will be set to the default value Front To Back

Now we click OK.

[Keyboard shortcut Enter]
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4

.

After the Matrix Generator was closed MADRIX creates the new matrix with the size of 20 x 31 x  20.

If you need help to change the MADRIX 5 Preview from 2D to 3D presentation mode, please have a look at

the chapter »User Interface [GUI] > 3 Previews of the MADRIX 5 Help and Manual.

Congratulations! You have successfully learned how to create a 3D patch with the Matrix Generator.

http://help.madrix.com/m5/html/madrix/index.html?hidd_user_interface_preview_window.html
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1.3.4 2D Patch With The Patch Editor For DMX Output

In this tutorial you can learn how to create a 2D patch for DMX fixtures with the help of the Patch Editor.

Date: 10/2018

MADRIX Version: 5.0 (Created with)

Corresponding Video Tutorial: »Creating A 2D Patch For DMX Output With The Patch Editor

Note:

We will use the result of this task in the tutorials »Merge Patches, »Create Fixture Groups, »Export, Modify And

Update A Patched Fixture and »Layer Mapping. If you also want to have a look at this tutorials, it is recommended to

save the patch at the end of the tutorial.

Task: 

We have to create a patch for different fixtures with different pixel amount according to the following patch plan.

The patch consists of RGB PAR LED and 4 Pixel RGB Batten fixtures.

https://www.youtube.com/watch?v=a2GeqOf_pOU&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=5
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1

.

Please go in MADRIX to Preferences > Patch Editor. 

[Keyboard shortcut F3]
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2

.

The Patch Editor opens and you will see the current patch. If you open the Patch Editor after the start of

MADRIX (without loading a setup), you will find the default patch of 50 x 50 pixels.

The complete manual chapter about the Patch Editor you will find here: »Using The Software > Patching >

Patch Editor

3

.

When we want to create a new patch in the Patch Editor, it is recommended to start with an empty patch.

Please click the New button in the toolbar and an empty patch will be generated

http://help.madrix.com/m5/html/madrix/index.html?hidd_preferences_patch.html
http://help.madrix.com/m5/html/madrix/index.html?hidd_preferences_patch.html
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4

.

Now we can start to add the fixtures according to our patch plan. To add fixtures to the patch grid please click

the Add button in the toolbar.

5

.

The Add Fixtures window opens and the default Protocol and Product is selected if you open it the first

time.
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6

.

Now we need to change the settings in the Add Fixture window to patch the fixtures according to the patch

plan.

First we want to patch the 4 RGB LED PAR cans. We know it is a simple RGB light and requires 3 channel per

fixture. In that case we know we don't need to patch a specific fixture and we can use the !generic RGB

Light 1 pixel. 

In the Fixture section we don't need to change the Protocol and the Product.

· Protocol should be DMX 

· As Product it should be !generic RGB Light 1 pixel selected

In the Placement section we want to select the correct count and placement (Offset and Start Position)

according to the patch plan.

We know we have to patch 4 RGB LED PAR cans and when we have a look to the patch plan we see the "RGB

PAR cans" are on the top but there is one of the "4 Pixel RGB Batten" left of them and between every "RGB

PAR can" is a bit offset.

So we change the settings to:

· Count  X to 4. We don't need to change the Count Y and Z. It should be 1.

· The Offset X will be set to 1

· Start Position X will also be changed and set to 2.

In the Addressing section we don't have to change a setting this time. Because according to our patch plan

we start on DMX Universe 1 with DMX Start Channel 1 and the address assignment is from left to right.

After we finished the settings we can click Add
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7

.

Now you can see four fixtures are added according to our settings in the Add Fixtures window. Before we go

ahead with patching of the other fixtures we will compare it with the patch plan. If everything is ok, we can

continue the patching. If not, we should correct the wrong settings. 
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8

.

In this step we open the Add Fixtures window again and patch the five "4 RGB pixel batten" fixtures. From

our task we know there are 5 pixel battens and every one has 4 RGB pixels. In this example we want to

create the pixel batten as a fixture, which consists of !generic RGB Light 1 pixel. According to the patch

plan we add this fixtures below the par cans and start at the left side in the patch. The DMX start address of

the first pixel batten is 13 in DMX universe 1. Furthermore we can see there is a bit space between every pixel

batten, where the LED par cans are located.

Because of this requirements we have to set:

In the Fixture section we don't need to change the Protocol and the Product because we patched the

!generic RGB Light 1 pixel fixture already during patching the RGB LED par cans. The Add Fixtures

window will remember the last patched fixture

In the Placement section we want to create 5 pieces of 4 pixel batten starting at the left side with an offset

of 1 pixel below the PAR cans.

So we change the settings to:

· Count  X to 5

· The Count Y we change to 4

· Count Z  we don't need to change. It should be 1.

· The Offset X will be set to 1

· Start Position Y will be set to 3.

In Addressing section we have to change the settings for the Main Orientation because we want to use the

!generic RGB Light 1 pixel as a vertical batten and also the DMX Start Channel needs to be set to 13

according to the patch plan. If Auto Address is enabled in the Toolbar of the Patch Editor, MADRIX will

automatically set the DMX Start Channel to the next free address.

We have to change:

· Main Orientation to Vertical

· DMX Start Channel to 13

 

After we finished the settings we can click Add
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9

.

After adding the fixtures you can close the Add Fixtures window and the current patch should look like the

following picture

1

0

.

Now we have created the patch but we need to change the size of the Voxel Map that MADRIX can calculate

the effects on the correct size according to the patched fixtures. Therefor please open the Matrix Settings. 
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1

1

.

In the Matrix Settings window you can easily click at the Match Voxel Map Area button and MADRIX will

automatically set the correct Size for X, Y and Z.

In the next step you can click OK.

1

2

.

Now close the Patch Editor and you can see the new created patch consists of 4 pixels (the RGB LED PAR

cans) on top and 5 x 4 pixels (the 4 Pixel RGB Batten) below.

Congratulations! You have successfully learned how to create a 2D patch consisting of different fixtures in

MADRIX



[Part A] Configuration

//40www.madrix.com

MADRIX 5 Tutorials Version 1.0

1.3.5 2D Patch With The Patch Editor For DVI Output

This tutorial shows you how to create a 2D patch for several DVI fixtures with the help of the Patch Editor.

Date: 10/2018

MADRIX Version: 5.0 (Created with)

Corresponding Video Tutorial: »Creating A 2D Patch For DVI Output With The Patch Editor

Note: 

We will use the result of this task in the tutorial »Merge Patches, »Rotate Fixtures and »Layer Tiling With Offset. If

you want to have a look also at this tutorials, it is recommended to save the patch at the end of the tutorial.

Task: 

A patch with 3 different DVI fixtures should be created. In the patch plan we see a 25 x 25 pixel in the middle and

a 8 x 16 pixel fixture on every side of it.

https://www.youtube.com/watch?v=jOWinqWji14&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=4
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1

.

In MADRIX please go to Preferences > Patch Editor . 

[Keyboard shortcut F3]
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2

.

The Patch Editor opens and you will see the current patch. If you open the Patch Editor after the start of

MADRIX (without any setup is loaded), you will find the default patch of 50 x 50 pixels.

The full manual of the Patch Editor you will find in the MADRIX help in the chapter: »Using The Software >

Patching > Patch Editor

3

.

When we want to create a new patch in the Patch Editor, it is recommended to start with an empty patch.

Please click the New button in the toolbar and an empty patch will be generated

http://help.madrix.com/m5/html/madrix/index.html?hidd_preferences_patch.html
http://help.madrix.com/m5/html/madrix/index.html?hidd_preferences_patch.html


[Part A] Configuration

//43www.madrix.com

MADRIX 5 Tutorials Version 1.0

4

.

Now we can start to add the fixtures according to our patch plan. To add fixtures to the patch grid please click

the Add button in the toolbar.

5

.

The Add Fixtures window opens the default Protocol and Product is selected when you open it the first

time.



[Part A] Configuration

//44www.madrix.com

MADRIX 5 Tutorials Version 1.0

6

.

In this step we need to set the correct settings in the Add Fixtures window to add the first fixture of our

patch according to the patch plan.

In the Fixture section we have to change the Protocol and the Product. 

· Protocol changed to DVI 

· As Product we select !generic DVI 8x16 RGB

In the Placement section we set the correct count and placement (Offset and Start Position) according to

the patch plan.

In this example we add only one of the 8x16 pixels fixture.

So we change the settings to:

· Count  X/Y/Z to 1 for every direction.

· The Start Position X should be 1.

After we finished the settings we can click Add
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7

.

One DVI fixture with a size of 8 x 16 pixels is now added and the patch should look like in the following

image.
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8

.

In this step we open the Add Fixtures window again and add the 25 x 25 pixels fixture. This fixture is also

available as generic fixture. The fixture is located right besides the 8 x 16 pixel fixture. That means we have

to patch it at Position X = 9.

In the Fixture section we don't need to change the Protocol because it it still set to DVI. 

· The Product we have to change to !generic DVI 25x25 RGB

In the Placement section we want to add only one of the selected fixture at Start Position X = 9, Y = 1 and Z

= 1

So we change the settings to:

· Start Position X to 9.

 

After we finished the settings we can click Add
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9

.

After you have add the fixtures you can see two different DVI fixtures with different resolutions in the patch

grid of the Patch Editor.
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1

0

.

According to the patch plan the 8 x 16 pixels fixtures is not located on the top left position. The middle point

of both fixtures are at the same level. So we have to move the 8 x 16 pixels fixture. To move the fixture

simply go with the mouse over the fixture and press and hold the [left mouse button] down and move it via

Drag & Drop to Pixel Y = 5 for the top pixels
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1

1

.

Only the 8 x 16 pixels fixture on the right side of the 25 x 25 pixels fixture is missing. Because of we have add

already such a fixture we want to create a copy of this fixture. Therefor please select the 8 x 16 pixels fixture

on the left side, press and hold the [Ctrl key] of your keyboard and the [left mouse button] down together.

During you hold the keys down please move the mouse and you have a copy of the selected on the mouse.

You can drag it to the desired position.
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1

2

.

According to the patch plan we drop it at position X = 34 and Y = 5.

1

3

.

Now we only have to change the size of the Voxel Map. If you don't change the settings of the Voxel Map

to the correct size, MADRIX is calculation the effect wrong. 

To change the size please open the Matrix Settings.
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1

4

.

In the Matrix Settings you can easily click the Match Voxel Map Area and MADRIX is calculating the

correct settings according to the created patch. 

After the values are changed please click OK.

1

5

.

Now you can close the Patch Editor and the created patch should have a size of 41 x 25 x 1 pixels.

Congratulations! You have successfully learned how to create a 2D patch of different DVI fixtures with the Patch

Editor.
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1.3.6 2D Patch With The Patch Editor For Combined Output Of DMX And DVI
Fixtures

In this tutorial you will learn how to create a combined 2D patch which consists of DMX and DVI fixtures.

Date: 10/2018

MADRIX Version: 5.0 (Created with)

Corresponding Video Tutorial: »Creating A 2D Patch For DMX & DVI Output With The Patch Editor

Task: 

In this tutorial we will create a patch consisting of 8 LED PAR 56 RGB and a P10 DVI Wall with a resolution of 50 x

50 pixels per element.

https://www.youtube.com/watch?v=MN4tLXUbxDQ&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=6
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1

.

We will start with an empty patch. So please open the Patch Editor and create a New patch. If you don't

know how to create an empty patch in MADRIX 5, please have a look at the following tutorial:

2D Patch With The Patch Editor For DMX Output

2

.

Now we can start to add the fixtures according to our patch plan. To add fixtures to the patch grid please click

the Add button in the toolbar.
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The Add Fixtures window opens. When opening the first time the default Protocol and Product is selected

when you open it the first time.
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4

.

We  can start to add the fixtures according to our patch plan.

In the first step we want to patch 4 RGB LED PAR cans on the left side. As we know from our patch plan it is

a simple RGB light and requires 3 channel per fixture. That means we don't need to patch a specific fixture

and can use the default

!generic RGB Light 1 pixel fixture.

In the Fixture section we have to select:

· DMX as Protocol 

· !generic RGB Light 1 pixel as Product

In the Placement section we want to select the correct fixture count according to the patch plan.

We have to add 4 x RGB LED PAR cans on the left side. So we change the settings to:

· Count  X to 4. We don't need to change the Count Y and Z. It should be 1.

In the Addressing section we don't have to change a setting this time. According to our patch plan we start

on DMX Universe 1 with DMX Start Channel 1 and the address assignment is from left to right.

After we finished the settings we can click Add
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5

.

Now you can see there are 4 fixtures patched on the left side.
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6

.

In this step we want to add the fixtures which are responsible for the DVI output. Therefor please open the

Add Fixtures window again.

In the Fixture section we have to change the Protocol and the Product. 

· Protocol changed to DVI 

· As Product we select !generic DVI 50x50 RGB

In the Placement we set the correct count, the Offset between fixtures and the Start Position according to

the patch plan.

In this example we add 7 in X and 3 in Y of the !generic DVI 50x50 RGB fixture

So we change the settings to:

· Count  X to 7 and Count Y to 3.

· The Start Position X should be 50 and also the Start Position Y should be 50.

After the previous changes we have finished the settings in the "Add Fixtures" section and now we can click
Add.
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We would like to work with a pixel exact mapping. For this reason we have to move our added DMX fixtures

according to our patch plan. 

When we have a look at patch plan, we can figure out the first PAR can is located at the very left side and the

distance between this 4 fixtures is the size of one DVI tile. That means the distance between two DMX fixtures

is 50 pixels.

So we have to relocate the fixture with the Fixture ID 2 to position 50, fixture with the Fixture ID 3 to 100

and the one with the Fixture ID 4 to position 150.

To change the position of a fixture please select the desired fixture and navigate to the Voxel Mapping

section of the Settings on the very right side of the Patch Editor. After you have set the desired value you

have to click Apply.

That means you need to select the fixture with the Fixture ID 2, set the Position X to 50 and click Apply.

Repeat this step for the fixture with the Fixture ID 3, set the Position X to 100 and click Apply.

And again for the fixture with the Fixture ID 4, set the Position X to 150 and click Apply.
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In this step we want to add the 4 PAR cans,which are located  on the right side next to the DVI fixtures. For

this task we want to copy the 4 already added PAR cans. To copy the 4 PAR cans we select all 4 fixtures. You

can easily select the fixtures when you press and hold the [Shift key] + [left mouse button] down, now

please create a bounding box around the desired fixtures. When you now release the [mouse button], the

fixtures in the bounding box are selected. When you now press and hold the [Ctrl key] + [left mouse

button] while having one of the fixtures selected, a copy of the fixtures will be created when you [move] the

mouse. 

If Auto Address was enabled during the copy process,  the next free DMX addresses will be assigned to the

newly added fixtures.

9

.

As explained in Step 7 we want to work pixel exact. That means we have to adjust the correct positions for

the copied fixtures, too. According to the patch plan we have to move the PAR cans on the right side to pixel

Position X = 300, 350, 400 and 450. The Y position is always 1.

Because we have copied the 4 fixtures with the correct offset and the fixtures are still selected we can easily

move all fixtures together to the correct position.
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0

.

In this step we have to set the correct matrix size. Please open the Matrix Settings window via the toolbar.

1

1

.

After you opened the Matrix Settings you will see the current set Size and Color Depth. 

It is important to set the matrix size and color depth to the correct value. Otherwise MADRIX will calculate the

effects wrong.

If the size is too small, not all fixtures will get color information from the MADRIX effects.

If the size is to big, MADRIX will waste PC performance.

In both situations the center of the calculated MADRIX effect is not the center of your full patch.
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2

.

The easiest way to set the correct matrix size and color depth is by using the Match Voxel Map Area and

Match Color Depth buttons. After you press the buttons the Matrix Settings will be changed automatically.

After a click at the OK button the settings will be accepted.

1

3

.

When we now close the patch and have a look at one of the MADRIX previews, our patch as the correct size.

At the top line we will find 8 Par cans and a DVI screen below.

Congratulations! You have created a combined patch of DMX and DVI fixtures.
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1.3.7 3D Patch With The Patch Editor For DMX Output

This tutorial shows you how to create a 3D patch with the help of the Patch Editor.

Date: 06/2019

MADRIX Version: 5.0f (Created with)

Corresponding Video Tutorial: »Creating A 3D Patch For DMX Output With The Patch Editor

Task: 

We have to create a patch for seven DMX controlled 5 x 5 LED RGB Pixel Panels which are installed on four layers

in the truss rig.

https://www.youtube.com/watch?v=tzrItlYSK-s&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=7
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1

.

To create this patch we have to remove all current existing fixtures. So please open the Patch Editor and

create a New patch. If you don't know how to create an empty patch in MADRIX 5, please have a look to the

following tutorial:

»2D Patch With The Patch Editor For DMX Output

2

.

Now we can start to add the first fixtures according to our patch plan. To add fixtures to the patch grid please

click the Add button in the toolbar.
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3

.

After the Add Fixtures window opens we can start to add our desired fixtures. 

If you want to learn more about all settings of the Add Fixtures window, please have a look at the following

link:

»Using The Software > Patching > Patch Editor

According to the task we have to patch 5x5 LED RGB Pixel Panels. In the first step we want to add the first

two panels for the front left and right side.

· Protocol should be DMX 

· As Product we have to choose !generic Panel 5x5 horizontal 

In the Placement section we want to select the correct count and placement (Offset and Start Position)

according to the patch plan.

As described above we want add the first two fixtures at Z-Layer 1 in this step.  

We change the settings to:

· Count  X to 2. We don't need to change the Count Y and Z. It should be 1.

· The Offset X will be set to 43

· Start Position X should be 1.

After all necessary settings are changed please click Add.

http://help.madrix.com/m5/html/madrix/index.html?hidd_preferences_patch.html
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When we now have a look at the Patch Grid we can see, that we have add two 5x5 Pixel Panels at Z-Layer 1.
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Before we add the next two fixtures at Z-Layer 2 we need to change the view to this Z-Layer.

To change the view of the different Z-Layers simply click the Z-Layer button or the Arrows buttons beside

this button to navigate through the different Z-Layers in the Patch Editor.
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Now we want to add the two 5x5 Pixel Panels at Z-Layer 2. Therefor please open the Add Fixtures window

again. In the Add Fixtures window you will still find the settings of the last added fixtures.

In case of this tutorial we want to patch the same Product but at another position. That means we only need

to change the Placement before we add the fixtures. If Auto Address is enabled, MADRIX will automatically

calculate the next free DMX address for us. So we also don't need to change the settings in this section.

In the Placement section we have to change:

· The Offset X will be set to 27

· Start Position X should be changed to 9 and Start Position Z  should be changed to 2.

Please click the Add button to insert the fixtures to the patch.
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When we have a look to Z-Layer 2, we find the two added 5x5 Pixel Panels. 
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In this step we add the two 5x5 Pixel Panels at Z-Layer 3. Therefor please open the Add Fixtures window

again and change the necessary settings in the Placement section.

· The Offset X will be set to 11

· Start Position X should be changed to 17 and Start Position Z  should be changed to 3.

After we have changed the settings we click Add.
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When we have a look at our patch plan, we have to add one more 5x5 Pixel Panel at Z-Layer 4. So we have to

change the settings in the Placement section and Add the last fixture for this patch

In the Placement section we have to change:

· Count X must be changed to 1

· The Offset X can be set to 0

· Start Position X should be changed to 25 and Start Position Z  should be changed to 4.



[Part A] Configuration

//72www.madrix.com

MADRIX 5 Tutorials Version 1.0

1

0

.

In this step we have to set the correct matrix size. Please open the Matrix Settings window via the toolbar

and click the Match Voxel Map Area button. Now you can see the Size X, Y and Z will be changed to the

needed Voxel Map Area. The matched Voxel Map Area includes all fixtures of this patch from the front top left

fixture to the back bottom right on. With a click at OK the settings will be accepted and MADRIX will now

calculate the effects at this size.

1

1

.

Now we have patched all fixtures according to our task. 

As we can seen the Patch Editor creates an own slice for every Z-Layer. With the help of this slices we can

create complex patches and our focus will be on one Z-Layer.

To get an overview about all Z-Layers we can activate the View From Z-Layer To  Z-Layer option in the

Patch Editor. Now the fixtures on all Z-Layers which are not fully overlapped will be visible in one Z-Layer

slice.
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After we closed the Patch Editor we can have a look at the 3D Mode of the MADRIX Preview and we can see

a small 3D patch on which we are able to create stunning effects.

Congratulations! You have successfully created a 3D Patch with the Patch Editor in MADRIX.
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1.3.8 Create Fixture Groups

This tutorial shows you how to create Fixture Groups in MADRIX 5.

Date: 08/2019

MADRIX Version: 5.1 (Created with)

Corresponding Video Tutorial: »Create Fixture Groups

Note: 

Before you start to read this tutorial, it is recommended to work through the tutorial »2D Patch With The Patch Editor

For DMX Output.

Task: 

We have to create Fixture Groups for different sections in the patch. A Fixture Group for PAR cans and a Fixture

Group for the 4 Pixel RGB Batten needs to be created.

When we have a look at the patch plan we can get an overview where the fixtures are located in this patch:

https://www.youtube.com/watch?v=BLX3xtIMnAY&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=8
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Please create the patch in MADRIX according to the tutorial »2D Patch With The Patch Editor For DMX Output.

When you now open the Patch Editor via Preferences > Patch Editor [Keyboard Shortcut F3], you will find

a patch which consists of 4 x RGB LED PAR cans and 5 x 4 Pixel RGB Battens.
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To create a Fixture Group we have to select the fixtures which should be added to the Fixture Group.

You can easily select fixtures in the patch grid by moving the mouse while pressing and holding the [Shift

key] + [left mouse button]. Now you are creating a bounding box. All fixtures in this bounding box will be

selected after the release of the [left mouse button].

In the first step we want to select the LED PAR cans via bounding box.
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After releasing the [left mouse button] the fixtures LED PAR Cans will be selected.

4

.

To create a Fixture Group please click the Create From Selection button in the toolbar of the Patch

Editor.
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The New Fixture Group window opens and we can change some settings.

· We change the Display Name to PAR.

· As Display Color: we choose Red.

After we have changed this settings we click OK  and now you will find the PAR group in the Fixture Groups

list.

6

.

In the following steps we will create a group for the 4 Pixel RGB Battens. But in this step we create and empty

Fixture Group first and assign the fixtures later to this group.

To create an empty Fixture Group in the Patch Editor please click the Create button in the toolbar.
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The New Fixture Group window opens again and we also change some settings.

· We will change Display Name to Bar.

· As Display Color: we choose Blue.

8

.
When we now click OK, we will find two Fixture Groups in the Fixture Groups List. The PAR Fixture Group

already includes fixtures and the Bar Fixture Group doesn't.

+
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In this step we want to select all fixtures which are responsible for the 4 Pixel RGB Battens. Because we want

to assign this fixtures to the Bar Fixture Group in the next step. Before we select the fixtures we select the

Bar Fixture Group first. To select the fixtures we are using the bounding box method like explained in Step 2.

1

0

.

After you have selecting all 4 Pixel RGB Battens please click Assign in the Fixture Group section of the

toolbar.
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When we now have a look to the Fixture Groups List, we can see the Bar Fixture Group now has all 4 Pixel

RGB Battens included.

Congratulations! You have successfully learned how to create Fixture Groups in MADRIX 5.
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1.3.9 Working With Background Image

In this tutorial you will learn how to work with background images in the MADRIX 5 Patch Editor.

Date: 08/2019

MADRIX Version: 5.1 (Created with)

Corresponding Video Tutorial: »Working With Background Images In The Patch Editor

Task: 

Now we have to create a patch for non regular shapes according to the image below. Today we are in the happy

position to define the DMX addresses by our own.

https://www.youtube.com/watch?v=ZdyeuS7tTKw&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=9
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We will start with an empty patch. So please open the Patch Editor and create New patch. If you don't
know how to create an empty patch in MADRIX 5, please have a look at the following tutorial:
»2D Patch With The Patch Editor For DMX Output



[Part A] Configuration

//84www.madrix.com

MADRIX 5 Tutorials Version 1.0

2

.

With the help of the background image functionality of the Patch Editor in MADRIX 5 we can easily create a

patch for this design.

To add a background image in the Patch Editor of MADRIX 5 please go to View > Background Image.
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Now we can load a background image in the Settings section on the right side of the Patch Editor.

To load the background image please click the Load button next to Image. In the next dialog you can

choose the desired image.
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After you load an image the size of the image could be to big. The Background Image Settings provides

the possibility to Scale an image. If you want, you can Keep the Aspect Ratio.
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In this example the Keep Aspect Ratio option is Enabled and the Scale factor is set to 2.
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After setting the correct size and position of the image we can start to patch the fixtures. To patch fixtures we

have to go back to the Voxel Map view (View > Voxel Map) [Keyboard Shortcut F5].



[Part A] Configuration

//89www.madrix.com

MADRIX 5 Tutorials Version 1.0

7

.
Now let us add the fixtures for the left circle. In this example we will use the "!generic RGB Light 1 pixel"

fixture to patch the fixtures in the circle. 

We will start to patch at the top fixture of the circle. That's why we set the Position X to 18 and the

Position Y to 2. As described in the task we are in the happy position to define the DMX addresses by our

own.

So we set the the DMX Start Universe to 1 and the DMX Start Channel also to 1.

If you don't know how to add DMX fixtures in MADRIX please have a look to the tutorial »2D Patch With The

Patch Editor For DMX Output.

If the position is not exact, you can easily change the position via Drag & Drop.
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After we have add one fixture we can copy this fixture and move it to another position. To copy a fixture

please select the desired fixture, press and hold [Ctrl key] + the [left mouse button] and move the mouse.

Now you can drag a copy of the selected fixture and drop it at a desired position. Of course in our example

we will drop it at a position where a PAR can is located in the image.

If Auto Address is enabled in the toolbar of the Patch Editor, MADRIX will automatically set the DMX Start

Address to the next free DMX Address.

We will repeat to copy the fixtures clockwise around the left truss circle.
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In this step we want to add the fixtures for the Diamond structure. According to the image there are 5 x 5

pixel panels installed. We want to add one !generic Panel 5x5 horizontal fixture at Start Position X 58

and Start Position Y 6. Because of the enabled Auto-Address the Patch Editor will set the DMX Start

Channel to the next free DMX channel.
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After we added the first fixture of this diamond shape we can easily copy and paste the other fixtures to

create the shape according to the background image in the Patch Editor.

As explained in Step 8 we can easily select the already patched !generic Panel 5x5 horizontal fixture.

Please press and hold [Ctrl key] + the [left mouse button] and move the mouse. Now you can drag and

drop the copy of the fixture to the left side of the next line. We will repeat this until we create the complete

shape.
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When we have a look at our patch respectively image, we can see we haven't patched the fixtures of the right

circle. We know circles on the left and right side are identically arranged. That means we can easily copy the

fixtures which we have added for the left side and drop it to the right circle-

Therefor please select all fixtures of the left circle. 

To select more than one fixture in the patch grid you can press and hold [Shift key] + the [left mouse

button] and move the mouse. Now you are creating a bounding box. All fixtures in this bounding box will be

selected when you release the 

[left mouse button].  
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After you have selected the fixtures of the left circle please copy it like explained in Step 8 and drop it at the

location of the right circle.
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To ensure that we have created the patch at the matrix origin we will go to Edit > Move Map Area To

Matrix Origin. Now the Patch Editor will automatically move the fixtures to the top left position.

The advantage of the move is MADRIX will not have free space at the top and left side of the patch. This will

save PC performance.
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In the last step we have to resize the size of the matrix. Therefore please open the Matrix Settings and

press the Match Voxel Map Area button. Now MADRIX will change the settings for Size X, Size Y and Size

Z automatically.

After you have changed the size please confirm with OK. 

1

5

.

When we now close the Patch Editor, we can see the patched fixtures are aligned according to the

background image in the preview.

Note: The background image of the patch is only in the Patch Editor visible.

Congratulations! You have successfully learned how to create a patch with a background image in MADRIX 5.
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1.3.10 Merge Patches

In this tutorial you will learn how to merge two patches in MADRIX 5.

Date: 09/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Merge Patches

Note: 

This tutorial is using the patches of the tutorial »2D Patch With The Patch Editor For DMX Output and »2D Patch With The

Patch Editor For DVI Output. It is recommended to work through this two tutorials first and save the patches.

Task: 

In this example we want to combine the results of two patches. After the merge the DMX fixtures should be

arranged on the top and in the middle of the DVI fixtures.

https://www.youtube.com/watch?v=V8pEE86_EJ4&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=10
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The result of the  »2D Patch With The Patch Editor For DMX Output consists of four RGB PAR cans and five 4 Pixel

RGB Batten.
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If you haven't saved the result of the »2D Patch With The Patch Editor For DMX Output tutorial, in the Patch

Editor please navigate to File > Save Patch As [Keyboard Shortcut Ctrl+Shift+S] and save the patch at a

desired directory.
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Now we will load or create the patch of the »2D Patch With The Patch Editor For DVI Output tutorial.
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According to our task the DVI fixtures should be arranged below the DMX fixtures after the merge.

We know the DMX fixtures are covering 6 pixel in the vertical direction. So we want to move all DVI fixtures

by 7 pixels in the vertical direction.

Therefore please select all DVI fixtures in this patch, set an Offset of 7 pixels in the Voxel Mapping section

and click OK.
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Now you can see the fixtures are moved and in the patch there are 6 pixels space on top.
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In the following step we want to start the merge process of two patches.

Therefor please go in the Patch Editor to File > Merge Patches...,select the saved patch of the »2D Patch

With The Patch Editor For DMX Output tutorial and click Open.
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Now the Merge Patches window opens and we can change some settings of the Merge Settings section.
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Because the imported/merged DMX fixtures should be set to the top middle position we need to change the

settings in the Adjusted Patch 2 column of the Map Area X line to 17. 

After you have changed this setting please click OK

+
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Now the DMX fixtures are merged to the DVI patch a the top center position.
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In the last step of this tutorial we have to change the Voxel Map Area to the correct size. Therefor please

open the Matrix Settings of the Patch Editor and click the button Match Voxel Map Area for an automatic

calculation of the correct size and adopt your settings by clicking OK.
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Now we can close the Patch Editor and we can see the new patch which is the result of the merge of two

patches.

Congratulations! You have successfully learned how to merge two patches in the MADRIX 5 Patch Editor.
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1.3.11 Import A Fixture List

This tutorial shows you how a fixture list can be imported in the MADRIX Patch Editor.

Date: 09/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Import A Fixture List

Note: 

· The MADRIX 5 Patch Editor is able to import fixture list in the CSV file format.

· The result of this tutorial will be used in the tutorial »Highlight Fixtures.

Task: 

In this tutorial a fixture list which was generated in a third party software (like 3D visualizer or CAD software) shall

be imported in the MADRIX software. The project we have to import looks like the following image.

Download:

The CSV fixture list for this example you can download under the following link: CircleAndDiamondImport.csv

https://www.youtube.com/watch?v=CLg-oFIHhmQ&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=11
http://help.madrix.com/tutorials/download/various/CircleAndDiamondImport.csv
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We will start with an empty patch. So please open the Patch Editor and create a New patch. If you don't

know how to create an empty patch in MADRIX 5, please have a look to the following tutorial:

»2D Patch With The Patch Editor For DMX Output
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To import a fixture list in MADRIX please select File > Import Fixture List...
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Now you have to navigate to the desired fixture list file. In this tutorial we are using the file

CircleAndDiamondImport.csv which you can download above. Please select the file and click Open.
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In the CSV Import Settings window we have to adjust the Syntax Settings for the file we want to import.

The CSV format is an open standard format and has several possibilities how the fields are separated. To

figure out how the fields are separated you can have a look to the file with the Microsoft Windows Editor or

any other plain text editor.

In the Data Preview section you can double check if the settings for the syntax are set correctly.
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In our example we have to Enable the Use Header Line option with 1 line and the Field Separator must

be changed to Tabulator. When we now have a look at the Data Preview, we will see a correct

representation of the columns and lines. If this is the case, we can click the Next button.
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The Fixture List Import Settings window opens. In this window we have to assign the desired columns of

the CSV fixture list to the correct import parameters.
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To assign a parameter please perform a double-click with the left mouse button at the Assignment line in

each column and the Parameter context menu opens.

8

.

For this fixture list import we assign the columns to the following parameter:

Column Assignment

Fixture Product

Patch DMX Address

DMX

Mode

None (will not

be used in

MADRIX)

Position

X

Position X
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Position

Y

Position Y

Position

Z

Position Z

The result should look like the following picture:
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After we assigned the parameters in the Fixture Settings Assignment section we need to have a look at

the Product Settings section. In this section we will get an overview about the different fixtures of the

fixture list to be imported. 

Furthermore we have to assign a MADRIX fixture for every product type in this list. To assign a product please

perform a double-click with the left mouse button at the Assigned Products column. Now the Products

window opens and you can search and select the desired fixture.

When we open the Products window the the Generic 5 x 5 RGB Blinder we choose:

· Protocol: DMX

· Product: !generic Panel 5x5 vertical

· Rotation: Original

Now please click OK.
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Of course the second entry in the list must also be assigned. For this fixture type we choose: 

· Protocol: DMX

· Product: !generic RGB Light 1 pixel

· Rotation: Original

After the settings please click OK.
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When we now have a look at the Import Preview section we will get an overview about the properties to

the importing patch. In this example we can figure out the Map Area in X and Y are very small for this

project. So we are able to scale it. The Scale option is available at the Position Settings section on the

bottom left side of this window. We want to Scale it 10 times in X and Y direction. After we set the scale

factor we click OK.
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As always when we work with a patch we have to set the correct voxel map area size. Therefore please open

the Matrix Settings, click the Match Voxel Map Area button and click OK.

1

3

.

Now the fixture list is imported and the correct size of the voxel map area is set. The patch should look like

the following image.

Congratulations! You have learned how to import a fixture list in MADRIX 5.
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1.3.12 Highlight Fixtures

This tutorial shows you how to highlight fixtures in MADRIX 5 with the help of the Patch Editor.

Date: 10/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Highlight Fixtures

Note: 

· In this tutorial we will use the patch of the tutorial »Import A Fixture List.

· The used visualization for this project was done with »Capture Visualisation. 

· If you don't know how to connect the visualizer file with MADRIX, please have a look to the Tutorial:

»Connecting MADRIX 5 With A Visualizer Using sACN.

Task: 

We have to verify if the positions and DMX Start Addresses of the following patch are assigned correctly. This patch

was created via the Import Fixture List function in MADRIX 5. When you want to learn how you can import a CSV

fixture list in MADRIX 5 please have a look to the corresponding tutorial: »Import A Fixture List.

Download:

An executable Visualizer file you can download under the following link: CirlesAndDiamond.exe

https://www.youtube.com/watch?v=q1V5eV8Bdg0&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=12
https://www.capture.se/
http://help.madrix.com/tutorials/download/various/CirlesAndDiamond.exe
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When we are sure that the DMX address assignment of the used fixtures is set correctly but we want to verify

the positions of it in the patch and in reality we can work with the Highlight functionality in the MADRIX 5

Patch Editor. 

To enable the Highlight functionality we simply have to click the Highlight button in the Patch Editor.

After we have enabled Highlight the MADRIX output will be disabled by default if we don't have changed the

settings in the Patch Editor Options (see Step 5).
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If Highlight is enabled and you select a fixture in the patch, by default a full on white output will be sent to

the selected fixture. 

In this example we select the top left LED Par can fixture and we can see it illuminates in white color.
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Of course it is also possible to select a fixture with more than one pixel. When the Highlight mode is

enabled the first pixel (pixel with the lowest DMX address) will flash. With the help function you can double

check the orientation of the real fixture. 

Please pay attention: If you rotate or flip a fixture in the MADRIX 5 Patch Editor, it will not change the

position of the flash pixel at the real fixture. In the tutorial »Rotate Fixtures you can find more information

about the different possibilities to rotate or flip fixtures in MADRIX.
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4

.

Of course it is possible to select more multiple fixtures when the Highlight mode is enabled.

In this example we select all fixtures of the patch with the keyboard via [Ctrl + A]. 

As result all selected fixture we be on. 
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5

.
Until now we have worked with the default settings of the Highlight functionality. The default settings are:

white highlight color and MADRIX Output is set to black. In MADRIX 5 we can change this settings in the

Options.

6

.

After we opened the Options window we have to go to the Highlight tab.

In this tab we can change the Highlight Color and also the Highlight Mode.
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7

.
In this step we want to change the Highlight Color to Red. As always in MADRIX you can change the color via

the Color Picker or via the Edit fields. After the change of the color we click OK.
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8

.
When we now select a select some fixtures in the Patch Editor during the Highlight mode is still enabled, we

can see the fixtures will now illuminate in red.

+
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9

.
The second setting in the Highlight tab of the Option is the Mode. Now we want to change the Mode to

Highlight Color And Output. After we have changed the option we click OK.

1

0

.

Now MADRIX is outputting the current running MADRIX effect. Additionally  the selected fixtures will be
highlighted in the color you have set.
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Please note: The Highlight Color of the selected fixtures in the Patch Editor and the output of the MADRIX

effect is now working in HTP mode.

Congratulations! You have successfully learned how work with the Highlight functionality in the MADRIX 5 Patch

Editor.
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1.3.13 Rotate Fixtures

This tutorial shows you how to rotate and flip fixtures in MADRIX 5.

Date: 10/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Rotate Patched Fixtures

Note: 

In this tutorial we will modify the patch of the tutorial »2D Patch With The Patch Editor For DVI Output.

Task: 

In this tutorial we want to rotate the left and right LED Screen. After the rotation we also want to move this two

fixtures to the top of the patch.

1

.

We already created a similar patch in the tutorial »2D Patch With The Patch Editor For DVI Output. In this

tutorials we want to use exactly this patch and modify it.

https://www.youtube.com/watch?v=-AkEvYWR2bA&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=14
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To open the patch please go to File > Open Patch and choose the saved patch.
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2

.

In this step we move all fixtures of the patch by 8 pixel in x direction. This step is necessary because when

MADRIX will rotate a fixture, it will rotate around the center of the fixture. If the result will end in the

negative, the rotation is not possible. In our task we have to rotate the left and right fixture by 90 degree. We

remember the left and right screen have a resolution of 8 x 16 pixels  and at the end the fixtures should

overlap.
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3

.

Before we rotate the desired fixtures we enable the Overlap mode. With the help of this option we are able

to rotate at the current position. This option is necessary because MADRIX will also not rotate a fixture if it will

overlap another fixture and the Overlap option is disabled. 

After Overlap is enabled the button will be illuminated in green.
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4

.

In this step we select the two fixtures we want to rotate. To select them we simply press and hold [Shift] +

click at each fixture with the left mouse button. To rotate this two fixtures we go to the Rotation option at

the Voxel Mapping section on the right side of the Patch Editor. In the Rotation menu we choose 90° and

click OK.

5

.
Now we can see that both fixtures are rotated around their own center.
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6

.

According to our task we have to move the two rotated fixtures to the top of the patch. Also this two fixtures

have to be placed that no fixture will be overlapped.

When we have a closer look at the fixtures we can see an arrow on each of them. An arrow to the top means

the fixture is not rotated. If the arrow is pointing to the left side, the fixture is rotated by 90°.

7

.
As always when we have changed something in the Patch Editor we have change the size of the Voxel Map

Area in MADRIX. Please open the Matrix Settings window, click the Match Voxel Map Area button and

click OK.
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8

.
When we now have a look at the MADRIX previews we can see a patch like in the following image.

+
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9

.
Normally we have finished the task correctly. 

But in this tutorial we also want to learn how we can rotate the fixtures around the common center of all

selected fixtures. In Step 4 we have learned how we can rotate several fixtures around the center of each of

them. In the following steps we want to rotate the whole selection.

Please select all fixtures via [Ctrl + A].
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1

0

.

Now please go to Edit > Rotate Selection By 180°. 

1

1

.

Now we can see all selected fixtures are rotated by 180° clockwise around the common center .
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Congratulations! You have successfully learned the different ways how to rotate fixtures MADRIX 5.

1.4 Configure Output And Input

In the following tutorials we want to have a look how we can configure the different Input and Output interfaces in

MADRIX 5.

MADRIX supports a wide range of industry standard controlling protocols like DMX, Art-Net, sACN, T9, 5A, VGA,

DVI, HDMI, Phillips Color Kinetics, Phillips Hue and more.
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1.4.1 Find USB-Connected DMX Interfaces

This tutorial shows you how to find USB connected interfaces in MADRIX 5.

Date: 10/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Find USB-Connected DMX Interfaces

Note: 

MADRIX 5 supports the USB connection only for MADRIX DMX interfaces.

Task: 

Today a MADRIX USB ONE and a MADRIX STELLA is connected via USB to the PC. We have to check if both

interfaces will be found correctly in MADRIX 5. 

1

.

To double check that the MADRIX software has found all connected USB interfaces correctly we have to open

the DMX Devices tab of the Device Manager in MADRIX. To open it please go to Preferences > Device

Manager 

[Keyboard shortcut F4].

https://www.youtube.com/watch?v=53COeQ4aTRU&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=15
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2

.

After we opened the Device Manager the DMX Devices tab is selected by default. If we have connected

the MADRIX interfaces via USB before we start MADRIX, the interfaces will be found automatically. 

In the DMX Devices list we can see a MADRIX STELLA was already found but according to our task also a

MADRIX USB ONE appears in the list .
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3

.

If we connect the MADRIX interfaces via USB after the start of MADRIX we have to click the Search button

below the list.

It seems the MADRIX USB ONE was not connected during the start of MADRIX. Therefore we click the

Search button. You can verify the progress of the search with the help of the Progress Bar below the

buttons.



[Part A] Configuration

//146www.madrix.com

MADRIX 5 Tutorials Version 1.0

4

.

If the connected MADRIX USB ONE was not found in the list of the DMX Devices list in the Device

Manager, we have to double check if MADRIX is able to load the USB driver. To double check the enabled

USB driver we have to open the Options window via Preferences > Options [Keyboard shortcut Ctrl + Alt

+ O]
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5

.

After the Option window opened please activate the Devices USB tab. In this tab you will find a list of all

available drivers for the MADRIX interfaces. 

In that case the MADRIX USB ONE / MADRIX NEO driver is disabled. We enable it with a click in the

Checkbox or at the String and click OK to close the Option window.
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6

.

Now we open again the DMX Devices tab of the Device Manager in MADRIX (Preferences > Device

Manager) and click again the Search button.

7

.

After the searching was finished MADRIX was finding the MADRIX USB ONE.

Congratulations! You have successfully learned how to find connected USB DMX interfaces in MADRIX 5.
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1.4.2 Assign DMX Universes

In this tutorial we will learn how we can assign DMX universes of connected DMX interfaces in MADRIX.

Date: 10/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Assign DMX Universes

Task: 

In this tutorial a MADRIX USB ONE and a MADRIX STELLA connected via USB. Now we have to assign the DMX

universes according to the following list:

Device Uni

ver

se

MADRIX

USB ONE

1

MADRIX

STELLA

Port 1

2

MADRIX

STELLA

Port 2

3

https://www.youtube.com/watch?v=h2UskJK2-6o&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=16
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1

.

To assign the DMX universes of an interface we have to open the DMX Devices tab of the Device Manager

in MADRIX. To open it please go to Preferences > Device Manager [Keyboard shortcut F4].

Please note: The DMX Universe assignment of the DMX Devices tab corresponds with the patched DMX

Universes in the Patch Editor.
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2

.

After we opened the Device Manager the DMX Devices tab is selected by default. If we have connected

the MADRIX interfaces via USB before we start MADRIX, the interfaces will be found automatically. If we

connect the MADRIX interfaces via USB after the start of MADRIX we have to click the Search button below

the list.

In this tutorial the MADRIX interfaces are connected before the MADRIX 5 software was started and we can

see 3 different entries. One for the MADRIX USB ONE and two for the MADRIX STELLA. 

The first entry will be selected by default.

As we can see in the list all ports of the different interfaces are automatically assigned to a universe. MADRIX

starts the universe assignment for each interface with universe 1.
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3

.

According to our task the USB ONE should be assign to DMX Universe 1. The Port 1 of the STELLA to

DMX Universe 2 and Port 2 to DMX Universe 3.

The USB ONE is already assigned to DMX Universe 1 and we don't have to change it. 

Now the Port 1 of the STELLA needs to be changed to DMX Universe 2. Therefor we select Port 1 and

change the Universe at the Settings section to 2. 

In the next step we select Port 2 and change the Universe at the Settings section to 3. 

After we changed the settings we click Apply.

Please note: MADRIX will assign the DMX universes after a click at OK or Apply.



[Part A] Configuration

//153www.madrix.com

MADRIX 5 Tutorials Version 1.0

4

.

When we now have a look at the list of the DMX Devices tab, we can see all DMX Universes are assigned

according to our task.

Congratulations! You have successfully learned how to assign DMX Universes to different fixtures in MADRIX 5.
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1.4.3 Connecting MADRIX 5 With Art-Net Nodes

In this tutorial we will learn how to find connected Art-Net nodes automatically in MADRIX 5.

Date: 10/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Connecting Art-Net Nodes

Note: 

· MADRIX 5 supports Art-Net interfaces which are fully compatible with Art-Net I, Art-Net II, Art-Net 3 and Art-Net

4. To find an Art-Net node automatically the node must support the Art-Net Poll/Reply mechanism.

· When you are working with Art-Net the used network card of the PC and all connected Art-Net nodes needs to

be working in the same IP-Address range but every node needs to have an unique IP-Address. More about the

configuration of the IP Address of the used network card you can find in the chapter »Art-Net [DMX Over

Ethernet] of the MADRIX 5 manual.

Task: 

In this exercise we have to connect one MADRIX LUNA 4 and one MADRIX LUNA 8. Both MADRIX LUNA

should be found by using the Art-Net Poll/Reply functionality. After the nodes were found please enable the

output ports and assign universe 1 to 8 to the output ports of the MADRIX LUNA 8 and DMX universe 9 to 12 to

the MADRIX LUNA 4.

https://www.youtube.com/watch?v=SFlk5V5pEY4&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=17
http://help.madrix.com/m5/html/madrix/index.html?hidd_device_page_net.html
http://help.madrix.com/m5/html/madrix/index.html?hidd_device_page_net.html
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1

.

When we want to work with Art-Net we have to configure the Art-Net nodes in the MADRIX Device

Manager. To open the Device Manager please go to Preferences > Device Manager.

[Keyboard shortcut F4].

2

.

After the Device Manager  opens please go to the Art-Net tab. If Art-Net is still disabled (the Enable

Checkbox is Off), please enable it via a click at this checkbox.
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3

.

In this step we want to search for connected Art-Net nodes. Please double check that Art-Net is Enabled and

click the Search button at the bottom left corner.
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4

.

After the search MADRIX has found two different Art-Net nodes. The first one is a MADRIX LUNA 8 which

consists of 8 output ports and 1 input port. The second one is a MADRIX LUNA 4 with 4 output ports and 1

input port.

In this step we want to enable the Art-Net synchronization functionality of MADRIX. With the help of the

ArtSync command the data of every port will be outputted synchronized if the Art-Net nodes supports the

ArtSync command. This will help to reach a better visual look of the output.

We want to Enable the ArtSync for every output port of the found Art-Net nodes. To select the all output

universes you can press and hold the [Ctrl key] + click on each desired line with the [left mouse button].

Now we Enable the ArtSync checkbox. By default Pre-Sync is activated. If you want to learn more about

the Sync Mode please have a look at the »corresponding chapters in the manual.

http://help.madrix.com/m5/html/madrix/index.html?hidd_device_page_net.html
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5

.

Now let us go back to the DMX Devices tab and we can find the list of all found DMX output ports. 

By default the found Art-Net port are disabled.

6

.

To enable the desired ports to output or input DMX data we have to select and Enable the desired ports. In

this tutorial we select all output ports and click the Enable checkbox in the Settings section.
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7

.

Now all output ports are enabled.

According to our task we have to assign the virtual DMX universe 9 to 12 to the output ports of the LUNA 4.

If you don't know how to assign universes to output ports in MADRIX 5 please have a look to the tutorial

»Assign DMX Universes.

Congratulations! You have successfully learned how to find connected Art-Net nodes automatically with the

Poll/Reply functionality in MADRIX 5.
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1.4.4 Manual Configuration Of An Art-Net Device In MADRIX 5

In this tutorial we will learn how to add Art-Net output ports manually in MADRIX 5.

Date: 10/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Manual Configuration Of An Art-Net Device

Task: 

In this tutorial we want to add one Art-Net node with 8 output ports manually to the list of Art-Net nodes in

MADRIX 5.

1

.

To Add and Configure Art-Net nodes in MADRIX 5 we have to open the Art-Net tab of the MADRIX Device

Manager. If you don't know how to open the Device Manager in MADRIX 5 please have a look to the tutorial 

»Connecting MADRIX 5 With Art-Net Nodes.

In the first step we want to add the node manually. Please double check if Art-Net is Enabled and click the +

button below the list.

https://www.youtube.com/watch?v=pNw8oBD8HKE&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=18
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2

.

The New Device Options window opens and we have to configure our new Art-Net device(s).

We want to configure an output node with 8 ports and the data should be send in Unicast Mode. 

We change the settings in the following way:

· Port Type should be set to Output by default. If not we change it.

· Number of New Devices needs to be changed to 2. According to the Art-Net standard, there is a

maximum 4 ports per Art-Net node. If a node has more than 4 ports several devices with the same IP-

Address must be configured.

· Port Count Per Device we change to 4. 

· We also Enable the option Send Via Unicast Mode. Otherwise MADRIX will send the data in Broadcast

Mode.

After we have changed this settings we click OK.
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3

.

Now we can see two new Art-Net nodes are added to the list. Each node has 4 Universe OUT. We can see

MADRIX has automatically assigned universe 1 to 8 but the IP-Addresses of two nodes are still wrong and we

need to configure it.

4

.

To change the settings of an Art-Net node please click the Configuration button.
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5

.

In the Art-Net Device Configuration we are able to change General settings, Device Port settings and the IP

Configuration.

In this tutorial we want to change:

· Short Name to Manually 01

· Long Name to Manual Art-Net 01

· IP-Address of the Send Unicast Mode to 10.0.0.100
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6

.

In this step we have to change the settings for the second entry on the list. According to our task we want to

create data for an 8 port Art-Net node. That means we also have to set the same IP-Address for the second

line. For a better overview we also want to change the Short Name and Long Name to the same name like the

first part.

To change the configuration for the second entry please repeat Step 4 and Step 5 for this line.

We want to change:

· Short Name to Manually 01

· Long Name to Manual Art-Net 01

· IP-Address of the Send Unicast Mode to 10.0.0.100

Congratulations! You have successfully learned how to add manually Art-Net output devices in MADRIX 5.
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1.4.5 Connecting MADRIX 5 With sACN Nodes Via Multicast

In this tutorial we will learn how to create a Multicast connection between MADRIX 5 and sACN nodes.

Date: 10/2019

MADRIX Version: 5.1b (Created with)

Corresponding Video Tutorial: »Connecting sACN Devices In Multicast Mode

Task: 

In this tutorial we have to add and configure 10 sACN output ports in MADRIX 5

1

.

To enable the ESTA sACN protocol in MADRIX 5 we have to go to the MADRIX Options (Preferences >

Options).

[Keyboard shortcut Ctrl + Alt + O].

https://www.youtube.com/watch?v=ZarERpSlJ0E&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=19
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2

.

In the Options we have to switch to the Devices Network tab and Enable the ESTA Streaming ACN

section.

Now you are able to choose the desired network card for the sACN connection, set the ACN Device Count

and the ACN ID. 

Please note: 

· In case of sending the data in Multicast mode you don't need to change the IP Address settings in

Windows. It will be automatically send to the 239.255.X.X IP address range. The IP Address label is only

used to identify the network card.

· You don't need to change the ACN CID. Every sACN device has an unique ID which MADRIX will generate

automatically.

In this tutorial we change the ACN Device Count to 10 and click OK.
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3

.

In the next step we have to go to the MADRIX Device Manager. To open the Device Manager please go to

Preferences > Device Manager.

[Keyboard shortcut F4].

4

.

In the DMX Devices tab we can see 10 ports are added and already enabled. If needed, we can configure

this ports. For instance we can set another virtual DMX universe in the settings section.
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Congratulations! You have successfully learned how you can connect sACN nodes in multicast mode with

MADRIX 5.
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1.4.6 Connecting MADRIX 5 With A Visualizer Using sACN

This tutorial shows you how to connect MADRIX 5 with a 3D visualizer software via sACN.

Date: 01/2020

MADRIX Version: 5.2 (Created with)

Corresponding Video Tutorial: »Connecting MADRIX 5 With A Visualizer Using sACN

Note:

· In this tutorial we are using a »Capture Presentation as 3D visualizer software.

· You can learn more about sACN in the following tutorial: »Connecting MADRIX 5 With sACN Nodes Via Multicast.

· If MADRIX 5 and the desired 3D visualizer is running on one and the same PC, it is required that the 3D

visualizer is started first.

Task: 

In this tutorial we have to connect the MADRIX 5 software with a 3D visualizer and both software are running on

one and the same PC.

Download:

Under the following link you can download the Capture Presentation and the corresponding MADRIX setup in a .zip

file: ConnectingVisualizer

https://www.youtube.com/watch?v=42Avxzil8f4&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=13
https://www.capture.se/
http://help.madrix.com/tutorials/download/various/ConnectingVisualizer.zip
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1

.

After you have downloaded and unzipped the file please start the Capture Presentation

(CirclesAndDiamond.exe). The presentation is an executable file. 

When you are using the Microsoft Windows default Firewall, this Firewall will popup with a "Windows Security

Alert".  Please enable the option Private networks, such as my home or work network and also Public

networks, such as those in airports and coffee shops and click Allow access to be able to send data to

the visualizer.
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2

.

Now the 3D visualizer starts.
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3

.

In the next step please start MADRIX 5 and open the downloaded MADRIX setup. To load the setup please go

to File > Open Setup and navigate to the path where the MADRIX setup is saved. In this example it is the

folder where you unzipped the downloaded file.
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4

.

Now MADRIX 5 loads the setup and the Open Setup Options appears. Please enable all options and click

OK.

5

.

The setup will be loaded and should look like in the following screenshot.
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6

.

Now we have to connect the visualizer with MADRIX 5. In this tutorial we want to connect it via sACN. To

enable the output of sACN data in MADRIX 5 we navigate to Preferences > Options.



[Part A] Configuration

//176www.madrix.com

MADRIX 5 Tutorials Version 1.0

7

.

In the Options window we activate the Devices Network tab and enable ESTA - Streaming ACN for the

desired network card. For this example we change the ACN Device Count to 5.
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8

.

After we activated the sACN output in MADRIX 5 we can send the data to the 3D visualizer and operate like

you are working in the real venue. 

Congratulations! You have successfully learned how you connect a 3D visualizer tool via sACN with MADRIX 5.
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1.4.7 Output To DVI-Based Fixtures

This tutorial shows you how to enable the output for DVI based fixtures.

Date: 11/2019

MADRIX Version: 5.2 (Created with)

Corresponding Video Tutorial: »Enable The Output For DVI-Based Fixtures

Note: 

· DVI based fixtures are fixtures which are connected to an output port of your graphic card like a Scaler of LED

Walls, Monitors, Projectors. The connection can be DVI, HDMI, VGA, Display Port. 

· We will work with the result of this exercise in the tutorial »Configure DVI Based Fixtures.

Task: 

In this tutorial we will enable the output for a DVI Wall with the resolution of 160 x 90 as patched in the Tutorial

»2D Patch With The Matrix Generator For DVI Output.

1

.

Please create or load the MADRIX Patch like explained in the Tutorial »2D Patch With The Matrix Generator

For DVI Output.

Please note: It is very important that the patch consists of DVI fixtures.

https://www.youtube.com/watch?v=j_jqK9IYe-c&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=20
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2

.

When we want to send the output data to a connected DVI Wall which is connected to an additional graphic

card output, we have to open a DVI Preview window.

Therefore please go in MADRIX to Previews > External Preview 1 > DVI. 

3

.

After you enabled the External DVI Preview window you will find it by default at the at the Top Left Corner

of the MADRIX User Interface.

Now you can move this Window via Drag & Drop to the position where the connected DVI Wall is capturing

the signal.

You can find more information about the configuration of the DVI Preview Window in the tutorial: »Configure

DVI Based Fixtures.
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Congratulations! You have successfully learned how to enable the DVI Preview Window in MADRIX 5.
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1.4.8 Configure DVI-Based Fixtures

This tutorial shows you how to configure an external DVI Preview Window.

Date: 12/2019

MADRIX Version: 5.2 (Created with)

Corresponding Video Tutorial: »Configure DVI-Based Fixtures

Note:

· We will work with the settings of the »Output to DVI Based Fixtures.

· Normally a DVI Wall controller is connected via VGA, DVI or HDMI cable to an additional output port of the

computer graphic card.

· Furthermore the Microsoft Windows Project  settings are normally set to Extend.

Task: 

In this tutorial we have to move and scale the External DVI Preview window which we have enabled in the

Tutorial: »Output to DVI Based Fixtures.

The connected DVI Wall has a resolution of 320 x 180 pixels and the controller will capture the signal form the top

left corner of connected output of the graphic card.

https://www.youtube.com/watch?v=-VIJG6Op4W8&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=21
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1

.

Please open the External DVI Preview1 in DVI mode like explained in the Tutorial »Output to DVI Based

Fixtures.
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2

.

To change the settings of the External Preview 1 please navigate in MADRIX to Previews > External

Preview 1 > External Preview Settings...
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3

.

The External Preview Settings window opens. As we can see the window is divided in several sections.

According to our task we will work with the sections DVI Window Position and DVI Window Size.

To learn more about all sections of the External Preview settings window please have a look at the

corresponding chapter in MADRIX 5 manual »DVI Output Settings and navigate to the topic Step-By Step-

Configuration.

http://help.madrix.com/m5/html/madrix/index.html?hidd_user_interface_dvi_window_funktions.html
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4

.

When we have a look at our task, the connected LED Wall controller will capture the video signal form the Top

Left position. Assuming the Project settings in Microsoft Windows is set to Extend and the LED Wall

controller is connected to the second screen, located right besides the main screen and the main screen has a

Full HD resolution, we have to move the External DVI Preview window to pixel 1920 from the left side and

0 pixel from top.

That means we have to change the settings in the DVI Window Position of the External Preview Settings

1 to:

· Left: 1920

· Top: 0 
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5

.

According to our task the LED Wall has a resolution of 320 x 180 pixels but our current patched DVI screen in

MADRIX has only a resolution of only 160 x 90. When we don't want to change the resolution of the LED

screen in the Matrix Generator or Patch Editor, we have the possibility to scale the External DVI

Window Size.   

Note: 

Scaling means MADRIX will scale the rendered effect according to the patched Matrix Size to the set display

area size by a scale factor. But scaling has some advantages:

· save PC performance

· depending on the scale factor you will not have a visual loss of quality when you working with MADRIX

stock effects

The disadvantages are:

· one pixel of the MADRIX patch will be outputted with more than one pixels

· If you want to output videos or images the visual quality of the output could be reduced

The scaling we setup in the DVI Window Size section. Please disable the Use Display Area Size checkbox.

Now we are able to set the settings according to our task:

· Width: 320

· Height: 180 

After we have changed the settings we click OK and the External Preview 1 in DVI mode will move to the

second screen (Pixel Position 1920 from the Left side) and with a scaled size of 320 x 180.
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Congratulations! You have successfully learned how to scale and move External Previews with the help of the

External Preview Settings in MADRIX 5.
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1.4.9 Connecting T9 Fixtures

In this tutorial you can learn how to configure a T9 controller in MADRIX 5.

Date: 12/2019

MADRIX Version: 5.2 (Created with)

Corresponding Video Tutorial: »Connecting T9 Fixtures

Note: 

The "Eurolite T9" protocol is a proprietary protocol. To output data to an activated T9 controller you have to patch

DVI fixtures in MADRIX. Under the following tutorials you can learn how to patch DVI fixtures in MADRIX 5:

»2D Patch With The Matrix Generator For DVI Output

»2D Patch With The Patch Editor For DVI Output

To work with the proprietary DVI protocols in MADRIX 5 the WinPcap Driver must be installed. You will find the

option to install the required WinPcap Driver during the installation process of MADRIX 5. If you have MADRIX 5

installed already without the WinPcap Driver, simply install MADRIX 5 again. Under the following link you can

learn how to install MADRIX: »Installation Of The MADRIX Software.

Task: 

In this tutorial one LSD AIO box is connected to the MADRIX PC via Ethernet cable and we want to configure this

connected T9 fixture in MADRIX 5. 

https://www.youtube.com/watch?v=jPcLQDENsMQ&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=22


[Part A] Configuration

//189www.madrix.com

MADRIX 5 Tutorials Version 1.0

1

.

To configure a proprietary DVI protocol in MADRIX 5 please start the Device Manager. To open the Device

Manager please go to Preferences > Device Manager.

[Keyboard shortcut F4].
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2

.

Now please go to the DVI Devices tab.

Below the Device List you will find the Search button. Please click this button and the search process will

start.
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3

.

After the search process was finished we will find a EuroLite T9 Device in the Device List. Now we can click

OK and MADRIX will send the information of the DVI patched Voxel to the T9 Device.

Note: MADRIX will starting to send the DVI data from the Front Top Left Voxel to the connected T9 Device. If

you want to patch the T9 Device to another position, please create also a »DVI Map in the Patch Editor.

Congratulations! You have successfully learned how to connect a T9 Controller to MADRIX 5.

http://help.madrix.com/m5/html/madrix/index.html?hidd_dvi_patch.html
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1.4.10 Remote Control Via DMX-IN

In this tutorial you will learn how to control MADRIX remotely via DMX Input.

Date: 12/2019

MADRIX Version: 5.2 (Created with)

Corresponding Video Tutorial: »Remote Control Via DMX Input

Note:

· To receive DMX data in MADRIX you will need to connect a MADRIX DMX interface via USB to the PC.

· In this tutorial a MADRIX USB ONE will be used. The MADRIX USB ONE is able to be used as DMX output and

DMX input (often used together with a so called 5 Pin XLR Gender Changer) interface.

Task: 

We have to configure MADRIX that it will be controlled remotely with the "Essential" remote protocol at DMX Start

Channel 106.

1

.

Please open the MADRIX Device Manager. To open the Device Manager please go to Preferences >

Device Manager.

[Keyboard shortcut F4].

https://www.youtube.com/watch?v=A5LcxCqnOBs&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=24
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2

.

When the MADRIX USB ONE was connected before the start of MADRIX and the driver was installed correctly,

MADRIX will find it automatically. 

If it was connected after the start, please click the Magnifier button below the Device List to find the USB

ONE
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3

.

By default the MADRIX USB ONE will be set to send DMX data. If we want to receive DMX data with this

interface, we have to change it.

To change the data direct we go to the Settings section, activate Input and click Apply.

4

.

To setup the DMX Input configuration please change the tab of the Device Manager to DMX Input.
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5

.

In MADRIX you are able to work with multiple DMX Input Devices. In this tutorial we will use only one and we

will configure it as DMX Input Device 1.

Please select the first Universe row and choose the connected MADRIX USBE ONE as DMX-IN Device.

6

.

After the USB ONE was assigned to DMX Input Universe 1 we have to activate the Remote option for this

interface.
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7

.

In this step we choose the desired Remote Control protocol.

According to our task we want to use the predefined Essential protocol. Please open the combo box in the

Remote Control section and select Essential.

You will find the description and DMX chart of the predefined Essential DMX Input configuration in the
MADRIX 5 manual chapter: »DMX-IN[Essential Protocol].

8

.

In the last step we have to change the DMX Start Address. In this tutorial we set it to 106.

After we have changed all this settings we click OK. 

Now we can control MADRIX remotely with 6 DMX channels starting from DMX channel 106.

http://help.madrix.com/m5/html/madrix/index.html?hidd_dmx_in_essential_protocol.html
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Congratulations! You have successfully learned how to create a DMX Input configuration with a predefined DMX

Input protocol in MADRIX 5.
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1.4.11 Remote Control Via Art-Net

In this tutorial you will learn how to control MADRIX remotely via Art-Net Input.

Date: 12/2019

MADRIX Version: 5.2 (Created with)

Note:

To receive Art-Net data in MADRIX you can use every Art-Net sender.

Task: 

We have to configure an Art-Net input configuration which will control MADRIX remotely via the "Standard"

protocol at DMX Universe 255, Start Channel 1. The Art-Net data should be received in Unicast mode and the IP

address of the sender is set to 10.0.0.1.

1

.

Please open the MADRIX Device Manager. To open the Device Manager please go to Preferences >

Device Manager.

[Keyboard shortcut F4].
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2

.

In the Device Manager please choose the Art-Net tab. If Art-Net is disabled, please Enable it.

3

.

In this tutorial we want to add an manual created Art-Net input device. Therefor please click the + Button.
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4

.

In the New Device Options window we select Input and click OK.

5

.

Now we manually added a new Art-Net input device and we have to configure this input device. To configure

an Art-Net device, please select it and click the Configuration button (gear wheel).



[Part A] Configuration

//201www.madrix.com

MADRIX 5 Tutorials Version 1.0

6

.

The Art-Net Device Configuration window opens and we can see the default value.

In this tutorial we want to change the Short Name to Input 1, the Long Name to ArtNet Input 1.

Also we have to change some settings according to our task:

MADRIX should receive the Art-Net data from universe 255. So we change Universe Port IN to 255.  

Furthermore it is required that MADRIX will receive the data in unicast mode from the IP address 10.0.0.1. To

activate this behavior please activate the option Receive Unicast Mode and set the IP address to

10.0.0.1.

After we have changed this settings we click OK to close the window.
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7

.

Now we go to the DMX Devices tab and we will find the created Input 1 node as input device

8

.

First of all we have to have to activate the Input 1. Therefor select it and click the Enable button in the

Settings section and click Apply.
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9

.

Now we have to configure the DMX input. Therefor we choose the DMX Input tab.

In the DMX Input tab we have to select Universe 1 and we have to choose the Input 1 as DMX-IN Device.

1

0

.

We want to use the Art-Net Input to control MADRIX remotely. To enable the remote control option in

MADRIX please select the first universe and enable Remote.
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1

1

.

According to our task we have to work with the predefined Standard protocol. We choose the Standard

protocol in the combobox of the Remote Control section.

1

2

.

Now MADRIX will be controlled remotely via the the manual configured Art-Net node "Input 1" Art-Net node at

DMX Start Address 1. 

You will find the DMX chart of the set Standard protocol under the following link: »DMX-IN [Standard

Protocol].

http://help.madrix.com/m5/html/madrix/index.html?hidd_dmx_in_standard_protocol.html
http://help.madrix.com/m5/html/madrix/index.html?hidd_dmx_in_standard_protocol.html
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Congratulations! You have successfully learned how create a Art-Net Input device in MADRIX 5.

1.4.12 Creating An User-Defined DMX-IN Remote Map

This tutorial shows you how you can create a user defined DMX Input remote mapping.

Date: 12/2019

MADRIX Version: 5.2 (Created with)

Corresponding Video Tutorial: »Creating An User-Defined DMX-IN Remote Map

Note: 

Before you start to read this tutorial, it is recommended to work through the tutorial »Remote Control Via DMX-IN.

Task: 

We want to control the Master, the Crossfader and the Stroage Places of Deck A and Deck B. Furthermore the

Master Fader should able to be controlled via DMX Input and the user interface.

1

.

Please configure a DMX Input device like explained in the tutorials »Remote Control Via DMX-IN or »Remote

Control Via Art-Net and go to the DMX Input tab of the Device Manager.

In the Remote Control section of the DMX Input tab please select the User configuration.

https://www.youtube.com/watch?v=BAuOQAchKAE&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=25
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2

.

To change the settings of the User configuration we click the Edit button in the Remote Control section. 

3

.

A blank DMX-IN Remote Editor opens.

In the MADRIX 5 manual chapter »DMX-IN Remote Editor you will find the full explanation of this tool.

http://help.madrix.com/m5/html/madrix/index.html?hidd_dmx_in_remote_editor.html
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4

.

Now we can start to add the desired functionality. According to our task the first remote channel should be

assigned to the Master value. Therefore please click + > Output > Master.
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5

.

The second Input channel needs to be assigned to the Crossfader. Please click + > Fade > Value to assign

it.
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6

.

Now we already added two function add. But both are assigned to DMX Channel 1.
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7

.

To change the assigned DMX Channel in the DMX-IN Remote Editor you can simply perform a right-click at

the DMX Channel column of the desired Function, change the value and press [Enter].

We change the DMX Channel of the Function Fade Value to 2.
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8

.

Now we add the control functionality of the Storage Place Deck A. Please go to + > Deck A > Place ID.
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9

.

We change the DMX Channel of the function Deck A Place ID to 3.

1

0

.

As the last function we want to add the remote control for the Storage Place of Deck B. To assign this function

please click + > Deck B > Place ID.
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1

1

.

We also assign the DMX Channel of the function Deck B Place ID to the next free DMX channel which is

channel 4.
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1

2

.

According to our task the Master value should be controllable via the user interface and also the connected

console. To assign this functionality we have to change the Execution value to On Value Changed.

To change the Execution behavior of the Master function we easily perform a right-click at the Execution

column and select On Value Change.
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1

3

.

Now the Master can be controlled via DMX Input and the user interface. All other functions can only be

controlled via DMX Input because the Execution is set to Always. That means the assigned function will

always be set to the value which will be received from the DMX Input. All user interface interaction of the

assigned function will be overwritten immediately.

Now we can close the DMX-IN Remote Editor via the X button in the top right corner. We don't need to

save the configuration because it is part of the MADRIX setup.
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1

4

.

In the Remote Control section of the DMX Input tab we can now see a 4 Channel User Configuration is

selected for the remote control of MADRIX.

Congratulations! You have successfully learned how to create a user defined DMX Input configuration in MADRIX

5.
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1.4.13 Remote Control Via MIDI

In this tutorial you can learn how to connect a MIDI controller in MADRIX 5.

Date: 06/2022

MADRIX Version: 5.5 (Created with)

Note: 

We are using an "AKAI Professional - APC 40 MKII" for this tutorial. But MADRIX 5 supports all MIDI controllers. A

list of the predefined controllers you will find in the manual under: »MIDI-IN.

Task: 

In this tutorial we want to use an "AKAI Professional - APC 40 MKII" to control MADRIX remotely with the

predefined MIDI mapping.

1

.

To configure a MIDI device in MADRIX please start the Device Manager. To open the Device Manager

please go to Preferences > Device Manager.

[Keyboard shortcut F4].

http://help.madrix.com/m5/html/madrix/index.html?hidd_midi_in.html
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2

.

Now please go to the MIDI tab.

If the MIDI device was connected before the start of MADRIX, the MIDI device will be found in the MIDI

Device list automatically. If you connect it after the start of MADRIX, please click the Search button to find

it.
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3

.

Now we select the desired MIDI Device and perform a double-click at the column Remote. If the connected

MIDI Device will be able work with MIDI Feedback, the Output for the desired MIDI Device will be activated

automatically. 

In this tutorial we have connected a MIDI Device with a predefined MIDI mapping. In that case MADRIX will

automatically choose this predefined MIDI mapping.

You will find an overview about the predefined MIDI mapping of the "AKAI Professional  APC 40 MKII" under

the following link: »Akai Professional APC 40 MKII

Congratulations! You have successfully learned how to control MADRIX 5 remotely via a predefined MIDI

controller.

https://help.madrix.com/m5/html/madrix/index.html?hidd_akai_professional_apc40_mk_ii.html
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1.4.14 Changing A Predefined MIDI-Map

In this tutorial you can learn how to change the mapping of a predefined MIDI controller in MADRIX 5.

Date: 06/2022

MADRIX Version: 5.2 (Created with)

Note: 

· We are using an "AKAI Professional - APC 40 MKII" for this tutorial. But MADRIX 5 supports all MIDI controllers

which are working according to the MIDI standard.

· To connect a MIDI controller in MADRIX please have a look to the tutorial »Remote Control Via MIDI.

Task: 

In this tutorial we want to change the predefined MIDI mapping of the connected "AKAI Professional - APC 40

MKII".

In the new MIDI mapping we will reduce the assigned MIDI commands according to the following image and table:
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PA

D

1

Cue List GoTo Cue 1

PA

D

2

Cue List GoTo Cue 2

PA

D

3

Cue List GoTo Cue 3

PA

D

4

Cue List GoTo Cue 4

PA

D

5

Cue List GoTo Cue 5

PA

D

6

Cue List GoTo Cue 6

PA

D

7

Cue List GoTo Cue 7

PA

D

8

Cue List GoTo Cue 8

F

1

Opacity Deck A Layer 1

F

2

Opacity Deck A Layer 2

F

3

Opacity Deck A Layer 3

F

4

Opacity Deck A Layer 4

F

5

Opacity Deck A Layer 5

F

6

Opacity Deck A Layer 6

F

7

Opacity Deck A Layer 7

F

8

Opacity Deck A Layer 8
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1

.

To change the MIDI remote control mapping please open the MIDI tab of the Device Manager, Enable the

desired MIDI device and activate Remote. If you don't know how to open the MIDI tab and activate the

Remote control in MADRIX, please have a look at the tutorial: »Remote Control Via MIDI.

2

.

Please select the desired MIDI Device and click the Edit button in the Remote Control section.



[Part A] Configuration

//224www.madrix.com

MADRIX 5 Tutorials Version 1.0

3

.

The MIDI Remote Editor opens and we can see the current MIDI mapping for the connected MIDI

controller. 

Note: For every predefined MIDI controller another MIDI mapping will be loaded.

To create a new MIDI mapping please click the New button.
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4

.

All assigned functions will be deleted. To add new functions for the MIDI assignment we click the + button.
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5

.

According to our task we have to map the Cue List GoTo functionality to the button 1 to 8 of the "AKAI

Professional APC 40 MKII". So we add the first GoTo function via + > Cue List Goto > Goto.
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6

.

Now a new Function was added and we have to set the correct MIDI command. The easiest way is to assign

it directly via pressing the desired button the MIDI controller. Therefor we activate Assign Extended Data.
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7

.

After we activated Assign Extended Data MADRIX will set every received command to the selected

functionality in the MIDI Remote Editor. That means we select the Goto function we just add and press

[Button 1] of the connected "AKAI Professinal APC 40 MKII". Now the MIDI Command changes to the

received one. When we are working with Buttons of a MIDI controller and want to activate a discrete entry in

a pool, we have to change the Maximum value for this function. 

The task requires to activate Cue 1 with the first Button of the MIDI controller. Therefor we set the MAX

value of the selected Goto function to 0. 

To change the value please perform a double-click on the MAX value column of the selected line.

Note: The values of a MIDI command starts at 0. So a value of 0 represents the first cue.
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8
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In this step we want to assign the settings for the MIDI Feedback which is provided by the "AKAI Professional

- APC 40 MKII". Therefor we have to change the Feedback value to State. Furthermore we need to change

the values for Active and Inactive. We want to set a green color if the cue is active and a blue one if it is

inactive. According to the "AKAI Professional - APC 40 MKII" manual we set the value 122 for Active and 41

for Inactive.

Note: 

· Not every MIDI controller supports the MIDI Feedback. If a controller doesn't support it, you can ignore

these settings.

· Every MIDI controller is working with different value for the different colors. The information about it should

be available in the manual of the desired MIDI Device   
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.

Now we want to add the Goto function for button 2 to 8. Because that's the same function we can duplicate

the function 7 times. To duplicate the Function please select the desired line and click the Duplicate button. 

1

0

.

We have learned how to change the MAX value and how to assign the correct MIDI command in step 7.
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1

1

.

With the connected MIDI controller we also want to add the possibility to control the Opacity of 8 Effect

Layers in every Storage Place of Deck A. To add this function for the first effect layer please go to 

+ > Deck A > Storage Place > Layer > Opacity > Layer 1.
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1

2

.

Of course we also have assign the desired MIDI Command for this function. Therefor please select the

previous added line and move the first [fader] of the "APC 40 MKII".
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1

3

.

We also duplicate this function 7 times. But now we have to change the Function for every line to the

another layer and assign the desired MIDI command.

To change the Function please perform a double-click and go to Deck A > Storage Place  > Layer >

Opacity and select a unique Layer number for each line.
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1

4

.

After we have duplicated and assigned the desired MIDI Command, the MIDI Remote Editor should consits

of 16 Functions all assigned to the MIDI controller according to our task.
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1

5

.

In the last step we want to change the Configuration Name to a desired name and close the MIDI

Remote Editor. MADRIX will ask you if you want to save it. You don't need to save the configuration because

it is saved as a part of the setup. But if you want to use the same mapping in another setup or on another PC,

you should save it.

Congratulations! You have successfully learned how to change and create a new MIDI Remote configuration in

MADRIX 5.
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1.5 Advanced Fixture Configuration

1.5.1 Creating Fixtures With The Fixture Editor

This tutorial shows you how to create new Fixtures with the MADRIX Fixture Editor and how to import this new

fixtures in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Note: 

How to create fixtures in MADRIX 5 you can learn in the tutorial: »Working With An Alternative Fixture Library.

Task: 

In this tutorial we want to create two new fixtures and prepare MADRIX 5 to work with it. The manufacturer for

both fixtures will be MADRIX. The first one is a 3 channel RGB and the second one is a 13 DMX channels, 4 pixels

RGB fixture with an additional dimmer channel. 

You can use the result of this tutorial to to create the patch »2D Patch With The Patch Editor For DMX Output. Simply

patch the created fixtures instead of the "!generic" fixtures.

Below are the DMX charts:

MADRIX - 3 Channel

RGB light

DMX

Channel

Function

1 Red

2 Green

3 Blue

MADRIX - 13

Channel / 4 Pixel

light

DMX

Chann

el

Function

1 Dimmer

2 Red

3 Green

4 Blue

5 Red

6 Green

7 Blue

8 Red
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9 Green

10 Blue

11 Red

12 Green

13 Blue

1

.

To create a new fixture respectively fixture library for MADRIX 5 we have to use the MADRIX 5 Fixture

Editor. The Fixture Editor is a sperate software tool. We can open it via Windows Start > MADRIX 5 >

MADRIX 5 Fixture Editor.

By default a blank MADRIX 5 Fixture Editor opens.
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2

.

To create a new fixture please go to Fixture > Add New Fixture.
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3

.

The Fixture and Channel section of the Fixture Editor is active now and we can add the desired settings.
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4

.

The first fixture we want to add is the "3 Channel RGB light". We set:

· Manufacturer: MADRIX

· Website: https://www.madrix.com

· Fixture Name: 1 Pixel RGB light

· Display Name: 1 Pixel RGB

· Operation Mode: 3 Channel

We don't need to change the other settings of the Fixture section, because settings for a 3 channel RGB one

pixel fixture are already set by default.

https://www.madrix.com
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5

.

Now we can start to add and assign the DMX channels according to the DMX Chart of the fixture.

The first channel is already assigned to the Red color and we only have to change the Name to Red.

To add a new channel please click the filled + button on the bottom of the Channel List. According to our

DMX chart on top of this tutorial the second channel is responsible for the color green. That means after we

clicked the + button we only change the Name to Green and also the the Color assignment to color 2

Green. 
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6

.

The last channel of the fixture we have to add is the channel number 3 which we have to assign to the Blue

Color.
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7

.

After adding the 3 channels and assigning the correct colors we click OK and the fixture will be added to the

Fixture List. 

If you need to modify the settings, simply perform a double click in the Fixture List at the desired Operation

Mode of this fixture and the fixture will become editable again.
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8

.

According to our task we have to add a second fixture. The second fixture is a "13 channel fixture" with 4

separate controlled RGB pixels.

As we have learned in Step 4 we want to fill the settings for the fixture first:

· Manufacturer: MADRIX

· Website: https://www.madrix.com

· Fixture Name: 4 Pixel light

· Display Name: 4 Pixel light

· Operation Mode: 13 Channel

For this fixture we also have to change the Voxel Count X to 4.

According to the DMX Chart of this fixture the first DMX channel is the Dimmer channel. 

Please note: MADRIX is controlling all dimmer values with the help of the color. That means the dimmer

must always be full on. 

We will handle this behavior with the Default Value at 255 and the option Fixed needs to be Enabled.

+

https://www.madrix.com
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9

.

The next DMX channel is responsible for the color Red. Simply click the left + button at the bottom of the

Channel List. Now please change the Name to Red and double check if the assigned Color is also set to

Red.
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1

0

.

We add the next two DMX Channels respectively colors as we have already learned in Step 5 and Step 6. 

Now all information for the first pixel are added.
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1

1

.

When we now click the + button again, the Fixture Editor will automatically add the next channel and assign

the colors to the second pixel. So you can add all channels for all pixels very fast.

Pay Attention: Please always double check the automatically assigned Voxel Position for all added color

channels. If the assignment is wrong, the light output of the fixture will be also wrong.
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1

2

.

After we click OK a second fixture will be added to the Fixture List.



[Part A] Configuration

//250www.madrix.com

MADRIX 5 Tutorials Version 1.0

1

3

.

After we have added the desired fixtures with different operation modes it is recommended to check the

fixture library for errors.

To check it please go to File > Check Library.

1

4

.

If everything was created correctly, the following hint will appear.

Otherwise a window with all issues per fixture will appear. 
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1

5

.

In the last step we have to save the previous created fixture library at a desired location and name on your

PC.

To save the new created fixture library we select File > Save Library As.

Congratulations! You have successfully learned how to create a fixture library with two fixtures in the MADRIX 5

Fixture Editor.
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1.5.2 Working With An Alternative Fixture Library

In this tutorial you will learn how to load an alternative Fixture Library in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Note: 

This tutorial is using the created Fixture Library of the tutorial Creating Fixtures With The Fixture Editor.

Task: 

In this example we want to exchange the fixture library and use a self created one.

1

.

Please start MADRIX 5 and select Preferences > Options [Keyboard shortcut Ctrl + Alt + O].
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2

.

In the Startup tab of the Options we have to enable Load Alternative Fixture Library and choose the

desired file by click the ... button.

After choosing the desired fixture library please click OK.

Pay attention: Please restart MADRIX 5 now because the fixture library will initialize only once at the start of

MADRIX5.



[Part A] Configuration

//254www.madrix.com

MADRIX 5 Tutorials Version 1.0

3

.

After the restart we will be able to patch only the fixtures which are included in this loaded fixture library.

Congratulations! You have successfully learned how to load an Alternative Fixture Library in MADRIX 5.
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1.5.3 Export, Modify And Update A Patched Fixture

This tutorial shows you how to export, modify and update already patched fixtures in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Note: 

· In this tutorial we will modify the created patch of the tutorial: »2D Patch With The Patch Editor For DMX Output.

· We will need to use the MADRIX Fixture Editor in this tutorial. If you are not familiar with the Fixture Editor,

please have a look to the following tutorial: »Creating Fixtures With The Fixture Editor.

Task: 

In this tutorial we have to imagine we have prepared a patch with RGB fixtures. But in the real venue there are

RGBW fixtures installed and now we have to fix it to run the show.

The prepared patch is the patch of the tutorial: »2D Patch With The Patch Editor For DMX Output.

1

.

Please start MADRIX 5, open the Patch Editor via Preferences > Patch Editor and load the desired patch. 
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2

.

According to our task we have to change the fixture definition for the patched RGB fixtures. Because we have

only patched RGB fixtures we select a desired fixture, navigate to File > Export Selected Fixture... and

save the fixture definition under a desired name and location.
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3

.

Please start the MADRIX 5 Fixture Editor now. 

If you don't know how to start the Fixture Editor, please have a look at the tutorial: »Creating Fixtures With The

Fixture Editor.
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4
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In this step we want to import the saved fixture definition. Please navigate to Fixture > Open Fixture

[Keyboard Shortcut Ctrl + Alt + O], select the exported fixture and click Open.
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5

.

After importing the fixture you will find this fixture in the Fixture List.
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6

.

According to our task we have to change the fixture definition from RGB to RGBW. Therefore we have to

change the Color Depth to RGBW in the Fixture section of the Fixture Editor.
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7

.

Now we can add the new channel via the + button, change the Name to Color White and also the Color

assignment to White. After we changed the settings we click OK to accept the changes.
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8

.

 We will save the new created respectively modified fixture library as a new one. To save a new fixture library

we go to File > Save Library As..., navigate to a desired location and save it with a desired name.
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9

.

Now back in MADRIX we open the MADRIX Options via Preferences > Options. In the Startup tab we

have to Enable the option Load Alternative Fixture Library and choose the just saved fixture library.

After doing the settings we can close the Options window via a click at the OK button. To initialize the

alternative fixture library we have to restart MADRIX. If you haven't saved the current patch or setup yet,

please save it before you restart MADRIX.
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1

0

.

After the restart of MADRIX we open the Patch Editor and the patch of the tutorial: »2D Patch With The Patch

Editor For DMX Output.

After you opened the patch we can perform the update of the fixture definition. Therefore we navigate to File

> Update Fixtures From Library.

1

1

.

Now MADRIX is asking if you really want to perform this update because you can't undo it.

We click Yes.
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1

2

.

MADRIX is checking and calculating the fixture count which will be updated.

Note: MADRIX will update all fixtures which are modified in comparison from the patched fixtures to the

fixtures in the current fixture library.

After we click OK MADRIX will update the current patch.

hen

1

3

.

After the update a yellow note at the bottom of the Patch Editor appears. This note means we have now

patched respectively updated the library with RGBW fixtures but the Color Depth of our Patch is still set to

RGB
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1

4

.

To change the Color Depth we open the Matrix Settings via the Toolbar or navigate in the menu to Edit >

Matrix Settings. 

In the Matrix Settings window we change the Color Depth to 4 and click OK.
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1

5

.

When we have a closer look at the DMX Start Channels of every fixture, we can figure out that the new fixture

definition is imported but the DMX Start Channel  was not changed. This is a wanted behavior. MADRIX will

update the fixture specific settings like color assignment, size of a fixture and so on. But it will not change

patch specific settings like placement or DMX Start Channel settings.

On the other hand it means we have to change this settings manually. 

An easy way to change the DMX Start Channel is in the DMX Map view to work via Drag and Drop. To

activate the DMX Map view we click the DMX Map button in the toolbar or navigate to View > DMX Map in

the menu.
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1

6

.

Now we want to change the DMX Start Channel for fixture 2 to 23. Therefore we select all fixtures except the

first one. Now we can change the DMX Start Channel via Drag and Drop. That means we click at one of the

selected fixtures with the [left mouse button] one of the selected fixtures, [hold the mouse button

down] and [move] the mouse to the left side. Now we can see all selected fixtures will move. We drop it

([release the mouse button]) at DMX Start Channel 5 of the second fixture. This is the next free DMX Start

Channel. 
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1

7

.

We have to repeat the changing of the DMX Start Address for every fixture. Every patched fixture consists of 4

DMX channels.

Note: To deselect one fixture of many you can easily press the [Ctrl] key and click with the [left mouse

button] at the desired fixture.
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1

8

.

To change the view back to the Voxel Map view we click the Voxel Map view button or navigate in the

menu to View > Voxel Map.

Congratulations! You have successfully learned how to export, modify and update an already patched fixture in

MADRIX 5.
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2 MADRIX Effects

2.1 Basics

In this tutorials you will learn the basic workflows to create stunning visual effects by using multiple layers. With

the help of the tasks we want to become more familiar with the MADRIX effect layers and the general settings.
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2.1.1 Add And Rename Layers

This tutorial shows you how to add and rename Effect Layers in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Add And Rename Effect Layers

Note:

· Before you start working on this tutorial it is recommended to be more familiar with the general usage of

MADRIX Effects and how to select them. If you want to learn more about the MADRIX Effects, please have a look

at the Effects section of the user manual: »Effects [Visuals].

· The result of this tutorial will be used in the tutorials: »Layer Visibility and »Copy Past And Insert Of Layers.

Task: 

Today we have to work with 2 different effect layers. Fort the first layer we will use the SCE Color Scroll and the

second layer the SCE Plasma effect.

The first layer should be renamed to Layer 1 and the second layer to Layer 2. Furthermore we want to have a look

at the impact of the order of the Effect Layers.

http://help.madrix.com/m5/html/madrix/index.html?hidd_handling_selection_effects_.html
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1

.

We select an empty Storage Place in MADRIX 5. In this example it is Storage 1, Place 1

According to our task we want to activate the SCE Color Scroll at the first Effect Layer. Therefor we click the

SCE Color button and choose SCE > Color Scroll.
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2
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Now we want to add a second Effect Layer by performing a right click at the Layer button and by selecting

New in the context menu.
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3

.

A new Effect Layer will be added at the right side of the the SCE Color Scroll layer.

Please note:

· New Effect Layers will always be added at the right side of the selected layer.

· New Effect Layers will always consists of the default effect SCE Color

· If you add a new Layer it will be positioned to the right. It is the foreground Layer.

· After a Effect Layer was added it will be selected (a selected Effect Layer will be illuminated in green).
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.

According to our task we choose the SCE Plasma effect for the second layer via SCE > Plasma.
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5

.

Now we can figure out the SCE Plasma effect is on top and no SCE Color Scroll is visible but still activated

and rendering.

In this step we want to rename the SCE Color Scroll layer by performing a right click at the Color Scroll

layer and selecting Rename in the context menu. 

6

.

In the middle of the MADRIX user interface you will find the Layer Name window. We call it Layer 1 and

click OK.
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7

.

Now we want to rename the SCE Plasma layer by performing a right click at the Plasma layer and selecting

Rename in the context menu.

8

.

We rename this Effect Layer to Layer 2. To accept the name we click OK.
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When we have a look at the layer tabs we can see both Effect Layers are are renamed from the default name

to the user defined name.
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0

.

In the last part of this tutorial we will have a closer look how to change the order of the Effect Layers and how

the visual result is changing. 

In Step 3 we learned that the further to the right the Effect Layer is located the more it is in the foreground.

At the moment Layer 2 which consists of the SCE Plasma is at the right side and thus in the foreground. If

we want to change the order of the layers, we simply select the desired layer via click and hold  the [left

mouse button], move the mouse to the desired layer position and drop it. 

In this example we want to move Layer 2 to the left side. Therefore we select it and move the mouse to the

left side during the [left mouse button] is clicked.
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1

1

.

As soon as the Layer 2 is at the left side we release the [left mouse button].

The visual result will also be changed. The SCE Color Scroll is now visible again because the corresponding

layer is now in the foreground. 

Congratulations! You have successfully learned how to add, rename and rearrange Effect Layers at a Storage

Place in MADRIX 5.
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2.1.2 Layer Visibility

In this tutorial you will learn how you to change the visibility of Effect Layers in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Layer Visibility Settings

Note:

In this tutorial we will work with the created Effect Layers of the tutorial: »Add And Rename Layers.

Task: 

Please have a look at the visual output when Blind or Solo of an Effect Layer will be activated and what happens if

the values for Submaster and Opacity of the second Effect Layer will be changed.

1

.

At the beginning of this tutorial we will have two Effect Layer as result of the tutorial: »Add And Rename

Layers.

https://www.youtube.com/watch?v=ovsyucmPK4k&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=28
https://www.youtube.com/watch?v=ovsyucmPK4k&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=28
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.

In this step we will Blind the second Effect Layer (Layer 2).

To Blind an Effect Layer we will have two Options:

· Option 1: Activating the B button at the Effect Area view. To Blind an Effect Layer at the Effect Area view

please activate the desired Effect Layer and click the B button. In this example we will select the Effect

Layer on the right 

side called Layer 2.

· Option 2: Change the view to Layer View and activating the Blind button of the desired Effect Layer. In

this example we activate Blind at channel strip Layer 2.

If you don't know how to toggle between the two views, please have a look to the MADRIX

manual at section: »Layers

If Blind of an Effect Layer is activate, the desired Effect Layer will be deactivated. That means nothing of this

effect will be visible. The B respectively Blind button will be illuminated in red as long as blind of the Effect

Layer is activated. Furthermore a red halo will flash at the layer tab of the blinded layer.

Note: It is possible to activate Blind for several Effect Layers.

http://help.madrix.com/m5/html/madrix/index.html?hidd_user_interface_layer_array_.html
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Now let us have a look at the output respectively preview when Solo will be activated.

To activate Solo of an Effect Layer we will have two Options:

· Option 1: Activating the S button at the Effect Area view. To activate Solo of an Effect Layer at the Effect

Area view please activate the desired Effect Layer and click the S button. In this example we will select the

Effect Layer on the

left side (background) called Layer 1.

· Option 2: Change the view to Layer View and activating the Solo button of the desired Effect Layer. In

this example we activate Solo at channel strip Layer 1.

If Solo of an Effect Layer is activate, the desired Effect Layer will be activated exclusively. That means all

other Effect Layers will be deactivated. The S respectively Solo button will be illuminated in green as long as

solo of the Effect Layer is activated. Furthermore a green halo will flash at the layer tab of the activated solo

layer.

Note: Only one Effect Layer can be set to Solo. Always the last activated Solo will take effect.
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According to our task we also will have a look how to work with the Opacity option.

To change the visibility of an Effect Layer we will have two Options:

· Option 1: Using the Opacity slider control button of the desired Effect Layer and change the Opacity to a

desired value. In this example we will change the Opacity of Layer 2 to 137.

· Option 2: Change the view to Layer View and change the value of the desired channel strip via the slider.

In this example we change the value of channel strip Layer 2 to 137.

With the help of the Opacity of a desired Effect Layer the transparency of the desired layer will be changed

and thus layers of the background will be visible depending on the value.

Note: If Effect Layers in the background should become more visible the Opacity of the Effect Layer in the

foreground must be decreased.
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.

To change the brightness of an Effect Layer without changing the Opacity we will have the option to work

with the Submaster. 

The Submaster value can be changed with the SUB button. If we decrease the value of the Effect Layer in

the foreground, no output will be visual. 
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If we need to set a discrete value of a Slider Control Button like Submaster or Opacity, we are able to

click the desired button once and type in the desired value. Valid values are between 0 and 255.

In this example we will change the value of the Opacity of Effect Layer called Layer 2 to 156. Therefore we

select the Opacity layer with an click, type in [156] via keyboard and press [Enter].
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Congratulations! You have successfully learned how to work with the visibility settings of Effect Layers in

MADRIX 5.
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2.1.3 Copy, Paste And Insert Of Layers

In this tutorial we will have a look how to copy Effect Layers in MADRIX 5 and the differences between past and

insert of it.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Copy, Paste And Insert Effect Layers

Note:

In this tutorial we will work with the created Effect Layers of the tutorial: »Add And Rename Layers.

Task: 

We have to copy Layer 1 of the current Storage Place, insert it as new Effect Layer between Layer 1 and Layer 2

and finally replace the content of Layer 2 with the content of Layer 1.  

https://www.youtube.com/watch?v=wiBwc51xbPg&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=29
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In the first step we will copy the Effect Layer called Layer 1 of the activated Storage Place. To copy an Effect

Layer please perform a right click at the desired Effect Layer and select Copy in the context menu.
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2
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Now we will insert it as a new Effect Layer between Layer 1 and Layer 2. Therefor we select the Effect Layer

called Layer 1, perform a right click and choose Insert in the context menu.
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Insert will add a new Effect Layer with the content of the copied Effect Layer. The inserted Effect Layer will

always be added at the right side of the selected Effect Layer and will be selected automatically.
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In this step we will overwrite the settings of Effect Layer called Layer 2 with the settings of Layer 1. The

settings of Layer 1 are already copied and we can overwrite it by pasting the settings at Layer 2.

To paste the settings we select Layer 2, perform a right click at Layer 2 and select Paste.
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Paste will overwrite the current Effect Layer settings with the settings of the copied Effect Layer.

Congratulations! You have successfully learned how to Copy, Paste and Insert Effect Layers in MADRIX 5.
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2.2 Working With Effect Layers

2.2.1 Layer Mapping

This tutorial shows you how to map Effect Layers in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Mapping Of Effect Layers

Note:

· In this tutorial we will work with the previous created MADRIX patch of the tutorial: »2D Patch With The Patch

Editor For DMX Output.

· Mapping is a powerful feature to create different content at different places of the underlying patch.

Task: 

Based on the already created patch we have to map a SCE Gradient effect at the Pixel Bar fixtures and a SCE

Color Scroll effect at the LED Pars. 

https://www.youtube.com/watch?v=LMqF8F0PKpo&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=30
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After we have loaded or created the patch like explained in the tutorial »2D Patch With The Patch Editor For

DMX Output we will change the effect of the effect layer to SCE Gradient. Now we are going to modify the

visual result of the gradient to only 3 colors which are red, green and blue.

· To delete colors please click the Delete box at the desired colors.

· If you want to change the color, position and fade property please select the desired color via the Move

box and perform your settings.

o Color left should be assigned to red and no Fade

o Color in the middle should be assigned to green, Position 0.33 and activated Fade

o Color right should be assigned to blue
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2
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Now we will start to change the size and position of the effect layer. With a click a the Map button the Map

Settings window opens.
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According to our task the SCE Gradient effect should be assigned to the pixel bar fixtures. So we map it to:

· Position Y: 2

· Size Y: 4

Please pay attention: In this example we are working Pixel based. You can change the range between

Percent and Pixel down in the middle of the Map Settings Window.
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4
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Now we will add a new Effect Layer via right click at the SCE Gradient layer and selecting New at the

context menu. 

If you don't know how to add layers in MADRIX 5 please have a look at the tutorial: »Add And Rename

Layers.

By the way: You don't need to close the Map Settings window when you are changing settings at the effect

itself or modify the amount of Effect Layers.
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The new added Effect Layer will be added in full size of the current Patch. That means the Map Settings are

default. Furthermore it will be added on the right of the SCE Gradient layer and thus in foreground. 

Now we will change the Effect of this layer to SCE Color Scroll.
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Now the SCE Color Scroll will be displayed at the full size of the patch and no SCE Gradient is visible.

7

.

According to our task the SCE Color Scroll should be mapped to the LED Pars. Therefor we change the Size

Y  of the SCE Color Scroll layer to 1 and we can close the Map Settings.
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Congratulations! You have successfully learned how to map Effect Layers in MADRIX 5.
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2.2.2 Layer Mapping With Fixture Groups

In this tutorial you will learn how to use the Fixture Groups as Presets to map Effect Layers in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Mapping Of Effect Layers By Using Fixture Groups

Note:

· In this tutorial we will work with the previous created MADRIX patch of the tutorial: »Create Fixture Groups.

· The result of this tutorial will be used in the tutorials: »Group Control For Live Control, »Group Control Using

Presets and »Group Control Using Group Value Chaser.

Task: 

 We have to assign an Effect Layer with a SCE Color Change effect to the Fixture Group PAR and a second

Effect Layer with a SCE Plasma to the Fixture Group Bar

https://www.youtube.com/watch?v=rjbDCDIeMPw&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=31
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In the first step we get an overview of the created patch of the tutorial »Create Fixture Groups.

We open the Patch Editor via Preferences > Patch Editor [Keyboard Shortcut F3]. Now we can find the

created patch and on the bottom left side the Section Fixture Groups which displays the 2 created groups.



[Part B] MADRIX Effects

//307www.madrix.com

MADRIX 5 Tutorials Version 1.0

2

.

Now let us start to map the Effect Layers according to the task. Therefor we close the Patch Editor. In the

MADRIX software we activate an empty Storage Place. In this example Storage Place 1 at Storage 1 is

activated. 

For the first Effect Layer we select SCE > Color Change. 

After the effect was selected we open the Map Settings window and choose the group PAR as Preset of the

Mapping section.

If you don't know how to open the Map Settings window, please have a look at the tutorial: »Layer Mapping.

Note: On top of the Preset drop down menu you will find all create Fixture Groups including the assigned

Display Color as icon.
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After choosing the desired Fixture Group the selected Effect Layer is running only at the assigned fixtures of

this group. 

In this example the SCE Color Change effect is running only at the assigned fixtures of the PAR Fixture

Group.

Note: You are able to double check the new size of the Effect Layer also in the Map Settings Preview in the

middle of the Map Settings window.
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In this step we add a new Effect Layer. Therefor we perform a right click the the Layer button and select

New in the context menu.



[Part B] MADRIX Effects

//310www.madrix.com

MADRIX 5 Tutorials Version 1.0

5
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A new layer will be added. This layer will be placed on the right side of the Color Change layer. That means

this layer will be placed in the foreground. Furthermore the new added Effect Layer won't be mapped by

default.

According to our task we assign the SCE Plasma effect to this Effect Layer. The SCE Plasma Effect will be

activated via SCE > Plasma.

As we can figure out and according to the explanation above the SCE Plasma effect will be visible in full size

over the entire patch. 
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According to our task we have to place the Plasma effect to the Fixture Group Bar. We open the Map

Settings window again and select Bar in the drop down menu of the Mapping Preset.

Note: Mapping of effects via a Fixture Group Preset is working according to a bounding box. That means

fixtures which are not in the Fixture Group but in the bounding box will also be influenced by the desired

effect layer.

7

.

Now also the SCE Plasma Effect Layer is mapped to the required position of our task and we can close the

Map Settings window.



[Part B] MADRIX Effects

//312www.madrix.com

MADRIX 5 Tutorials Version 1.0

Congratulations! You have successfully learned how to map Effect Layers with the help of Fixture Groups in

MADRIX 5.
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2.2.3 Layer Tiling

In this tutorial you will learn how to use tiling for Effect Layers in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Tiling Of Effect Layers

Note:

· In this tutorial we will work with the previous created MADRIX patch of the tutorial: »2D Patch With The Matrix

Generator For DVI Output.

· With the help of tiling MADRIX is able to repeat or mirror the content of the effect layer.

Task:  

 The effect SCE Wave / Radial with a Diamond shape and a Width of 30 should be repeated 4 times and

mirrored horizontally and vertically.

1

.

After we load the created patch of the tutorial:  »2D Patch With The Matrix Generator For DVI Output we will

change the effect to SCE Wave / Radial.

https://www.youtube.com/watch?v=ABNkl_SJdwo&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=32
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In this step we change the effect settings according to our task.

· Width should be set to 30

· Shape type should be changed to Diamond. 

We don't need to change the other effect parameter in this tutorial.

If you want to learn more about the SCE Wave / Radial, please have a look to the manual chapter: »SCE

Wave / Radial Effect.

http://help.madrix.com/m5/html/madrix/index.html?hidd_effect_sce_radial.html
http://help.madrix.com/m5/html/madrix/index.html?hidd_effect_sce_radial.html
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Now we will open the Map Settings window to set up the Tile settings. Therefore we click the Map button at

the effect section of MADRIX.

Pay attention: Please double check if the values of the Map Settings are displayed in Pixels or %. In this

tutorial we will work with Pixel values. The representation can be changed in the middle of the Map Settings

window.
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On the right side of the Map Settings window we will find the Tiling section. According to our task we have

to tile it into 4 sections. Therefor we can use the Preset Top Left at the Tiling section.
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After enabling the Preset Top Left we can figure out the current effect is running only to a quarter of the full

patch. 

When we now have a look to the Map Settings preview we can also figure out at which part of the patch the

tiling is active. The lighter green area displays the tiling size and position of the original content. The darker

green area displays the area where the content will be duplicated respectively mirrored.
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In our task we have to mirror the tiles vertically and horizontally. To enable this Tile Mode we select Mirror

HV in the context menu. 

7

.

The SCE Wave / Radial effect will now be displayed tiled and mirrored in 4 different parts and we can close

the Map Settings window.

Congratulations! You have successfully learned how to work with Tiling in MADRIX 5.
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2.2.4 Layer Tiling With Offset

This tutorial shows you how to work with the Tiling offset for Effect Layers in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Using The Offset To Tile The Effect Layers

Note:

· In this tutorial we will work with the created MADRIX patch of the tutorial: »2D Patch With The Patch Editor For

DVI Output.

· The result of this tutorial will be used in the tutorial »Layer Mapping And Mix Modes.

· With the help of offset at the tiles in MADRIX it is possible to map a duplicated tile with some space in relation of

the original tile.

Task:  

In the current patch we can find two small DVI screens. One on the left and one on the right side of this project.

On this two small screens a SCE Graph effect as straight line in yellow from left to right should run mirrored

horizontally. 

The screen in the middle of this patch should display a SCE Color Scroll from top to bottom with a Color Width of

75.

https://www.youtube.com/watch?v=zEIq_QI7WhQ&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=33
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In the first step we select the SCE Graph effect.
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Now we want to modify the SCE Graph effect according to our task. To make the effect running as one bar

from left to right we change the following settings:

· Frequency needs to be set to 0

· Direction must be changed to From Top to Bottom
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The SCE Graph effect is now running as one bar but we have to change the color to yellow. Therefor we

open the Color Table with a click at the Color button and delete all colors instead of one. We change this

single color to yellow.

Note: To change a color simply the select the desired entry of the Color Table and select the desired color

with a click at the color preview field or the type in the exact values at the color edit fields on top of the table.
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To assign the SCE Graph effect to the two small screens we open the Map Settings. 

Pay attention: Please double check if the values of the Map Settings are displayed in Pixels or %. In this

tutorial we will work with Pixel values. The representation can be changed in the middle of the Map Settings

window.

Please change the Position Y to 5 and the Size Y to 16 at the Mapping section. If you don't know how to

open the Map Settings please have a look at the tutorial: »Layer Tiling.

Note: The effect is still running at the full width of the matrix size. At the moment no Tiling is working.
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Now we want to tile the mapped effect to the 2 small screens. When we have a look at our patch we know

the Size X of the small screens is 8 pixels. So we set Size X to 8 at the Tiling section. Furthermore we want

to work with an Offset X of 25 pixels  and change the Tile Mode to Mirror H. Now we can close the Maps

Settings window.

By the way: The Offset X of 25 pixels corresponds to the size of the screen in the middle.

When we now have a look at our previews, the SCE Graph effect will be displayed twice. On the left side the

original one and on the right side a mirrored copy respectively tile.

Note: Tiling is always working on the Mapping size.
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According to our task a SCE Color Scroll effect should be mapped to the middle screen. To assign this effect

we have to add a new Effect Layer. We perform a right click at the Graph layer and select New in the

context menu.
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Now we choose the effect SCE Color Scroll.



[Part B] MADRIX Effects

//327www.madrix.com

MADRIX 5 Tutorials Version 1.0

8

.

To map the SCE Color Scroll to the desired position we open the Map Settings window again. 

At the Mapping section we change the following setting:

· Position X to 8

· Size X to 25
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After closing the Map Settings window we change the Color Width value of the SCE Color Scroll to 75 and

the Direction to from top to bottom. 

Congratulations! You have successfully learned how to use the Offset for Tiling of Effect Layer in MADRIX 5.
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2.2.5 Layer Mix Modes

This tutorial shows you how to work with Mix Modes in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Mixing Of Effect Layers

Note:

· In this tutorial we will work with the previous created MADRIX patch of the tutorial: »2D Patch With The Matrix

Generator For DVI Output.

· Layer Mix Modes are another powerful feature to create stunning and individual content in MADRIX 5. With the

help of the Layer Mix Modes it is possible to combine several MADRIX effects.

Task:  

 A SCE Metaballs effect should be displayed with constantly changing colors of the SCE Plasma effect.

1

.

After we load the created patch of the tutorial:  »2D Patch With The Matrix Generator For DVI Output we will

change the effect to SCE Metaballs.

https://www.youtube.com/watch?v=R_BdEi_y7Vg&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=34
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At the moment the SCE Metaballs effect is running at the only Effect Layer. According to our task we have to

combine it with the SCE Plasma effect. That means we need to add another Effect Layer. Therefor we

perform a right click at the Metaballs Layer tab and select New in the context menu.
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As always the new added Effect Layer will be inserted with the default effect (SCE Color) at the right side of

the selected Effect Layer. That means this new Effect Layer is on top.

We change the effect of this Effect Layer to SCE Plasma.
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As we can figure out the SCE Plasma effect consists only of colors without Alpha ratio by default. And thus

we still can't see the SCE Metaballs in the background. But we can combine the two effects with the help of

the Mix Modes in MADRIX 5.

To select the desired Mix Mode we click the Mix Mode button on top of the effect section.
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In this tutorial we choose the Mix Mode Mask because the SCE Metaballs effect should be displayed with

changing colors of the SCE Plasma.

Please Note: The the desired Mix Mode must be set in the Effect Layer on top and will influence all Effect

Layers which are underneath (left of the active one).

By the way: The Mix Mode Mask will use the Alpha channels of the Layers and only the parts where the

content of both layer will overlap will be displayed. All other parts will be black.

More about the Mix Modes in MADRIX 5 you can learn in the »Layers chapter of the manual.

http://help.madrix.com/m5/html/madrix/index.html?hidd_user_interface_layer_array_.html
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After the Mix Mode at the SCE Plasma Effect Layer was enabled the SCE Metaballs effect will be displayed

in the colors of the Plasma effect. 

That means it is possible to change the effect parameters individually for both Effect Layers but the output will

be combined.

 

Congratulations! You have successfully learned how to work with Mix Modes in MADRIX 5.
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2.2.6 Layer Mix Modes Link

In this tutorial you will learn how to use the Link option for combining Effects in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Mixing Of Linked Effect Layers

Note:

· In this tutorial we will work with the results of the tutorial »Layer Mix Modes.

· If the Link option has been enabled, Mix Modes only influence the Effect Layer underneath.

Task:  

 Based on the results of the tutorial »Layer Mix Modes we have to add a new Effect Layer and assign the SCE Split

Shapes effect. Only the new added SCE Split Shapes Effect Layer should be influenced by the Mix Mode Mask of

the SCE Plasma effect.

1

.

As result of the tutorial »Layer Mix Modes we got an Effect which consists of two Effect Layers. The SCE

Metaballs effect was assigned to the first (left) Effect Layer and the SCE Plasma Effect was assigned to the

second Effect Layer. Furthermore the Mix Mode Mask was enabled at the second Effect Layer.

https://www.youtube.com/watch?v=qqMZoBSM08c&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=35
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Now we want to start with the current task and add a New Effect Layer right beside the Metaballs Effect

Layer.

To add a new Effect Layer at the second position we select the first Effect Layer which is called Metaballs in

this  tutorial and perform a right click. In the context menu we select New.

By the way: If the new added Effect Layer is not at the second position, you can easily move the Effect Layer.

How to move Effect Layers you can learn in the tutorial: »Add And Rename Layers.
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According to our task we assign the SCE Split Shapes effect to the new added Effect Layer.

4

.

Now we can figure out the already enabled Mix Mode Mask of the Plasma Effect Layer will take influence on

all Effect Layers which are underneath.
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But the task requires only the Split Shapes Effect Layer should be influenced by the Mix Mode Mask of the

Plasma Effect Layer. 

If an activated Mix Mode should influence only one Effect Layer underneath, we have to activate the Link

option at the Effect Layer with the activated Mix Mode. 

So we activate the Plasma Layer and activate the Link option right besides the Mix Mode button.
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After the Link option has been activated, the colors of the Plasma effect will only influence the colors of the

Split Shapes effect. 

The Metaballs effect will be displayed with the color information of the effect it self.

 

Congratulations! You have successfully learned how to work with the Link option MADRIX 5.
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2.2.7 Layer Mapping And Mix Modes

This tutorial shows you how to work with Mapping and Mix Modes of the Effect Layers in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Mapping And Mixing Of Effect Layers

Note:

In this tutorial we will work with the result of the tutorial »Layer Tiling With Offset.

Task: 

We have to add two more Effect Layers. A SCE Color Change effect will be assigned to one of the new added

Effect Layers. This Effect Layer should be mapped and mixed with the already created Graph Effect Layer. As Mix

Mode please use Mask.

The second new Effect Layer needs to be assigned with the SCE Water effect. Furthermore some parameters of

the SCE Water effect should be changed:

· Energy: 100

· Length: 60

· Pitch X: 5

· Pitch Y: 5

This Effect Layer should be mapped to the size of the already existing Color Scroll Layer and mixed with the Mix

Mode Difference.

https://www.youtube.com/watch?v=CuOaSa2x4Ic&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=36
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.

The result of the tutorial »Layer Tiling With Offset consists of two Effect Layers. One Effect Layer is configured

with a modified SCE Graph effect and for the second Effect Layer a SCE Color Scroll has been assigned.
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When we have a look at our task, the current SCE Graph effect should be masked by the SCE Color Change

effect, which will be added in the next steps. So we change the color of the SCE Graph effect from yellow to

white. Therefor we click the Colors button, select the only color entry of the Color Table and change the

color to white. You can simply change the color with the help of the Color Picker or by setting the Color

Edit fields for red, green and blue to the desired value. In this case the values must be 255.
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Now we will add the first new Effect Layer. As we know this layer should be mapped exactly to the same size

of the already existing Graph effect. So we can duplicate the Graph layer and assign the desired effect later.

To duplicate the Graph layer we select it (the layer tab should be illuminated in green), now we perform a

right click and select Duplicate.



[Part B] MADRIX Effects

//344www.madrix.com

MADRIX 5 Tutorials Version 1.0

4

.

Two times the SCE Graph effect is now visible and also two Graph layers are now available. The duplicated

Effect Layer is added right besides the original Effect Layer and will be selected. 
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We change the effect of the duplicated Effect Layer to SCE Color Change via the Effect button on top of the

effect section.
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Because we duplicated the Effect Layer the mapping is exactly the same like the mapping of the Graph layer

underneath. So we don't need to care about the Mapping and we combine the two layers with the help of the

Mix Mode Mask.

If you want to learn more about Mapping Effect Layers please have a look at the tutorials: »Layer Mapping

and »Layer Mapping With Fixture Groups.

To activate the Mix Mode Mask simply click the Mix Mode button and select Mask.
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The Graph Effect Layer and the Color Change Effect Layer are now combined together via the Mix Mode

Mask and we can see the visual result at the Previews. The color of the tiled and mapped SCE Graph effect

will now be influenced by the SCE Color Change effect.

According to our task we have also to add a second new layer and combine it with the Color Scroll layer which

is located in the middle of this patch. As we have learned above to keep the map settings of one Effect Layer

also for another one we can duplicate the desired layer.

So we select the Color Scroll layer, perform a right click and select Duplicate again. 
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According to our Task we have to assign the SCE Water effect to this Effect Layer. Therefor we click the

Effect button again and select SCE Water.
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When we have a look at our task again, we have to change some of the effect parameters of the SCE Water

effect. To get a better visual impression we activate the Solo mode for this Effect Layer for a moment. 

With the help of Solo mode only this Effect Layer will be visible. All other layers will be blinded. If you want

learn more about the visibility settings please have a look at the tutorial: »Layer Visibility.

To activate the Solo mode we click the S button at the top right side of the effect section.

Now we change the following parameter:

· Energy to 100

· Length to the value 60

· Pitch X and Y we need to set to 5 for both parameters.
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We disable the Solo mode and as last part we have to activate the Mix Mode Difference to combine the

Effect Layers Color Scroll and Water. As we know we click the Mix Mode button and select Difference

from the context menu. 
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.

As result we can find 4 different Effect Layers. The first two layers are responsible for the visual output to the

small screens on the left and right side and the second two effect layers are responsible for the combined

visual output of the middle screen.

Congratulations! You have successfully learned how to use Mapping and the Mix Modes in order to get combined

output in MADRIX 5.
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2.3 Using Parameter Chasers

2.3.1 Effect Parameter Chaser For Effect Settings

In this tutorial we will learn how to create an Effect Parameter Chaser for effect settings in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Using Effect Parameter Chaser For Effect Settings

Note:

· The Effect Parameter Chaser is a powerful feature to change settings if the desired effect automatically.

· A detailed overview about the Effect Parameter Chaser you will find in the chapter »Chasers of the MADRIX 5

user manual.

Task: 

In this task we have to change the  Length and Width values of the SCE Wave / Radial automatically with the

help of a Effect Parameter Chaser.

The chaser should consists of 3 steps.

· Step 1: Length and Width should be set to 30

· Step 2: Length should be set to 150

· Step 3: Width should be set to 100

The Fade Time between the steps should be 2 seconds and the Wait Time 1 second. Furthermore the Chaser

should playback the steps in Ping Pong mode.

https://www.youtube.com/watch?v=CCiVz3bf-s4&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=37
http://help.madrix.com/m5/html/madrix/index.html?hidd_effect_parameter_chaser.html


[Part B] MADRIX Effects

//353www.madrix.com

MADRIX 5 Tutorials Version 1.0

1

.

In the first step we choose an empty Storage Place and activate the SCE Wave / Radial effect via the Effect

button on top of the Effect section in MADRIX 5.
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Now we want to open the Effect Parameter Chaser for the Effect Layer. Therefor we perform a right click at

the Chaser button on the top right side of the Effect Layer and select Edit in the context menu.

3

.

A small but powerful window, the Effect Parameter Chaser opens.
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We want to add the first step of the Effect Parameter Chaser. We set the value Length and Width to 30

and click the + button at the Effect Parameter Chaser. After the + button was clicked the first entry with

the current settings will be added.
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In this step we want to change the Description of the first entry to Small Radial. To change the Description

value please perform a double click at the desired column and enter the name.
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To add the second step of the chaser we change the value of the parameter Length to 150 according to our

task and click the + button again.

Pay attention: The Effect Parameter Chaser will always add the current value. That means you have to

change the parameter value fist and add a new step after the changes.



[Part B] MADRIX Effects

//358www.madrix.com

MADRIX 5 Tutorials Version 1.0

7

.

For the last step of the Effect Parameter Chaser we have to change the Width to 100 and click + in order

to add another Chaser step.
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Now all 3 steps are added to the Effect Parameter Chaser according to our task.

In the next steps we have to change the Fade Time and the Playback Mode.

The Wait Time is already set to 1 second by default.
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We have to change the Fade Time for all steps to 2 seconds. Therefor we select all Steps with the help of the

keyboard shortcut [Ctrl]+[A]. To edit all lines at the same time please perform a right click at one entry of

the Fade Time column and press the key 2 at our keyboard.

After the number 2 is set at the active column please press [Enter].
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As last modification of this tutorial we want to change the Playback Mode to Ping Pong. So please click the

Playback Mode button and select Ping Pong.
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When we now start the playback of the Effect Parameter Chaser, the parameter will be changed according to

our settings of the chaser steps. Furthermore as long as the chaser is playing, the user interface is locked for

changing parameters.

Congratulations! You have successfully learned how to work with an Effect Parameter Chaser in MADRIX 5.
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2.3.2 Effect Parameter Chaser For Map Settings

This tutorial shows you how to use the Effect Parameter Chaser for Map settings in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Using Effect Parameter Chaser For Map Settings

Task: 

Create a SCE Counter from 10 to 0 continuously which will have a size of 60 percent and will be displayed

randomly every second in another corner.

1

.

According to our task we select the SCE Counter effect.

https://www.youtube.com/watch?v=W9nHQ2PXNDw&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=38
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Because the counter should run from 10 to 0 again and again we don't need to change the effect settings and

we can open the Map Settings with a click at the Map button.
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Now please make sure the Map Settings are working with Percent values. To double check the settings please

have a look at the two buttons at the bottom middle. The % button should be activated.

If % is activated we will change the size of the Effect Layer to 60 for Size X and Size Y.
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In this step we will open the Effect Parameter Chaser therefor we perform a right click at Effect

Parameter button and select Edit in the context menu.
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To save Map Settings in the steps of the Effect Parameter Chaser we have to activate the correct

Parameter. Please click the Parameter Selection button, disable Effect Settings and enable Layer Map

Settings. After changing this settings please click OK.

Note: Only the enabled parameters of a chaser will be saved in the chaser steps. In addition MADRIX 5

provides the possibility to save different parameters per step in a chaser.
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The SCE Counter effect is already running in the top left corner so we can click the + button at the Effect

Parameter Chaser to add the first step.
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To move the Effect Layer with the SCE Counter effect to the top right corner we change the value for

Position X to 40. 

By the way: The Position of a layer is specified with the top left corner. 
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Now we can click the + button at the Effect Parameter Chaser again to add the second step.



[Part B] MADRIX Effects

//371www.madrix.com

MADRIX 5 Tutorials Version 1.0

9

.

In this step we want to move the Effect Layer to the bottom right corner. So we set the values for the

Position X and Position Y to 40.

Note: To double check if the positions are correct you can also have a look to the Mapping Preview in the

middle of the Map Settings window.
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To also add this Map settings as a step to the Effect Parameter Chaser we click the + button again.

1

1

.

As last Map settings for this tutorial we want to set Position X to 0 and Position Y to 40. So the effect will

be displayed on the bottom left side.
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We also want to add this settings as an Effect Parameter Chaser step. Therefor we click the + button

again.
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According to our task the SCE Counter should be displayed randomly at different corners and change the

position every second. For us it means the steps of the Effect Parameter Chaser should be activated randomly.

Therefor we activate the playback mode Random at the Playback Mode Selection of the Effect

Parameter Chaser. 

Because the default Wait Time is set to 1 second every step of the Effect Parameter Chaser will playback

for a second. We don't need to change time settings for this task.
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When we now activate the Playback of the Effect Parameter Chaser we can figure out the Effect Layer

with the SCE Counter effect will change the position every second randomly according to the 4 steps in the

chaser list..

Congratulations! You have successfully learned how to use an Effect Parameter Chaser to chase Map settings in

MADRIX 5.
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2.3.3 Storage Place Parameter Chaser For Opacity Settings

In this tutorial we will learn how to create Storage Place Parameter Chaser in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Using Storage Place Parameter Chaser To Fade-In Effect Layers

Task: 

We have to create a kind of Fade-In effect with different fade times per effect layer. 

The whole lighting effect consists of 2 Effect Layers. 

The first one is a SCE Gradient with two colors. The two colors are Red and Black. Furthermore the Direction

should be set to Shape Circle Implode.  

The second Effect Layer consists of the SCE Starfield with white stars and a Rotation of 50.

All other effect setting should be left default.

Always when the Storage Place will be activated no output should be visible for 0.5 seconds. After this time the

SCE Gradient Effect Layer should be enabled with 2 seconds Fade Time. 

After another 3 seconds the SCE Starfield Effect Layer should be enabled with 2 seconds fade time.

After fading in the different Effect Layers the effect should run without automatic changes until it will be

deactivated by selecting another Storage Place.

https://www.youtube.com/watch?v=gYC4ApArcPo&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=39
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In the first step we enable the SCE Gradient effect.
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According to our task the Gradient should only consists of two colors. The first one should be red and the

second color black. Therefor we delete all colors in the color gradient control with the help of the Delete

boxes below the gradient.

To change  the first color we select the color via the Move box and change the color to red. After chancing

the first color we select the second Move box and set the color to black.

Note: If you don't know how change, add or delete colors in a MADRIX color gradient, please have a look at

the chapter »Using Colors and Intensity of the MADRIX User Manual.

http://help.madrix.com/m5/html/madrix/index.html?hidd_color_selection.html


[Part B] MADRIX Effects

//379www.madrix.com

MADRIX 5 Tutorials Version 1.0

3

.

The task requires the representation of the Gradient as Circle Implode at the matrix. 

To activate the Circle Implode we click the Direction button, navigate to Shape 2D > Circle Implode and

select it.
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Now we add a new Effect Layer for the SCE Starfield effect. 

Therefor we perform a right click at the Gradient Effect Layer and select New in the context menu.

5

.

To activate the SCE Starfield we open the Effect selection and select the SCE Starfield effect.
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Now the SCE Starfield effect is running in front of the SCE Gradient effect. According to our task we have

only to change the Rotation value to 50.
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In our task it is required to create a kind of Fade In effect with different fade times per layer. To create such a

visual result we will use the Storage Place Parameter Chaser.

To open the Storage Place Parameter Chaser we perform a right click at the Storage Place Parameter

Chaser button at the Storage section and select Edit.
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An empty Storage Place Parameter Chaser opens.
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In this tutorial we only want to add changes of the visibility settings in the Storage Place Parameter

Chaser. 

Therefor we click the Parameter selection button and enable only Layer Visibility Settings. All other

parameters should be disabled. After changing the parameter we click OK.
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Before we start to add steps to the Storage Place Parameter Chaser we want to change the MADRIX effect

parameter view to Layer view via a click at the Layer button on the bottom left corner of the Effect Section.
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In the Layer view we will find the direct access to the Opacity sliders per Effect Layer.

For the first chaser step we want to set the values for both Effect Layers to 0 to create the required blackout.

Now we click the + button at the Storage Place Parameter Chaser to add the first step.

We will set the timing for Wait Time and Fade Time in Step 14 after all steps of the Storage Place

Parameter Chaser have been added.
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According to our task the SCE Gradient Effect Layer should be faded as first. So we set the Opacity of the

Gradient Effect Layer to 255 and click the + button at the Storage Place Parameter Chaser again.
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In this step we change the Opacity of the Starfield Effect Layer also to 255 and click the + button at the

Storage Place Parameter Chaser.
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All required steps are added to the Storage Place Parameter Chaser. But we have to change the timing

according to our task. 

In the task it is required to have a blackout for 0.5 seconds. As we can remember the first step is responsible

for this kind of black out in this chaser.

So we perform a double click at the column Wait Time of the first entry and set the value to 0.5 with the

help of the keyboard.

The Gradient Effect Layer should be faded in 2 seconds after the black out. So we perform a double click at

the Fade Time column of step 2 and change the value to 2. To accept the value we can press [Enter].

When we have again a look at our task, the SCE Starfield Effect Layer should be enabled after another 3

seconds with a fade time of 3 seconds. To delay the fade in of the SCE Starfield Effect Layer in this chaser

we have to increase the Wait Time of the chaser step before. That means we have to perform a double click

at the Wait Time column of the second step and set the value to 3. Furthermore we have to perform a

double click at the Fade Time column of the third chaser step and change the value also to 3.
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To run the Storage Place Parameter Chaser only once at activating the desired Storage Place we have to

change the Loop Count to 1.and the Automatic start (AS) option should be enabled.
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When we now start the Storage Place Parameter Chaser for a test, we can figure out the chaser will be

played only for one loop and the Effect Layers are faded according to our task.

Congratulations! You have successfully learned how to work with a Storage Place Parameter Chaser in MADRIX

5.
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2.4 The Group Control View

2.4.1 Group Control For Live Control

This tutorial shows you how to use the Group Control during live operating in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Using The Group Control In Live Operation

Note:

In this tutorial we will work with the result of the tutorial »Layer Mapping With Fixture Groups.

Task: 

In this tutorial we have to dim the maximum value for the fixture group PAR to 200 and the value for the fixture

group Bar to 100. Furthermore we want to flash the PAR group at the end of this task.

1

.

To change the brightness of the Fixture Group we have to activate the Group Control view. Therefor we

click the View button in the middle of the MADRIX user interface and select Group Control.

https://www.youtube.com/watch?v=6IlvsN35SBg&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=40
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In the Group Control view we can find the dimmer slider for all previous create Fixture Groups.
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According to our task we have to set the value for the Bar Fixture Group to 100. 

To change the value of a Fixture Group we have the possibility to move the slider to the desired value or enter

the value at the Edit field below the Fixture Group.
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We also have to change the value for the BAR Fixture Group to 200.

Note: The visual result of dimming a Fixture Group will be only displayed in the Main Output Preview.
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When we have a look at our task we have to flash the PAR Fixture Group. To flash a Fixture Group we have

to click the Group Name button below the slider.

Note: As long as the button is clicked the desired Fixture Group will be set to the maximum value. As soon

as the button will be released the value will be postponed to the value before the flash was activated.

Congratulations! You have successfully learned how to work with the Group Control to change the brightness in

MADRIX 5.
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2.4.2 Group Control Using Presets

In this tutorial we will learn how to work with Group Presets in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Using Fixture Group Presets

Note:

In this tutorial we will work with the result of the tutorial »Layer Mapping With Fixture Groups.

Task: 

In this tutorial we have to add 3 different Group Presets. Furthermore the Fade Time for the Preset changes

should be set to 3 seconds.

The first Preset should set all Fixture Group dimmer sliders to the maximum (255).

The second Preset should set the PAR Fixture Group to 0 and the Bar Fixture Group to 255 and the last preset in

this tutorial should invert the previous settings. That means the PAR Group should be set to 255 and the Bar

Fixture Group should be set to 0.

1

.

The view of MADRIX is already set to Group Control. If you don't know how to activate the Group Control

view, please have a look at the tutorials: »Group Control For Live Control.

https://www.youtube.com/watch?v=vC4Z0zWYiZw&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=41
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When we have a look at our task, the first Group Preset should set all Fixture Groups to the value 255. If you

are working with the default group settings, the values of the Fixture Groups are already set to 255. So we

only need to save this settings as first Group Preset.

Therefor we change the Group Preset Description to Group Full ON and click the Set button 
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The Set Group Preset window opens and we can change the Preset Number. In this tutorial we want to save

it as the first Preset and we can click OK.
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Now the first Group Preset was added and the Preset button is illuminated in blue as always if something is

stored in MADRIX at a button.
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Now we start to prepare the settings for the second Group Preset. 

We change the Group Preset Description to PAR Off and the value for the Fixture Group PAR to 0.

After this settings are done we click the Set button again.

According to our task we want to save this setting as second Group Preset. That means we have to double

check the Preset Number in the Set Group Preset window and apply it with a click at the OK button.
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.

The second Preset button will be also illuminated in blue.
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In this step we want to prepare and add the third Group Preset.

According to our task we change the Group Preset Description to Bar Off and the dimmer value for the

PAR Fixture Group to 255 and for the Bar Fixture Group to 0.

After we modified the Group Preset Description and the desired Fixture Group values we perform a right

click at the Group Preset button 3. In the context menu we click Set.
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Now the third Group Preset has been saved.

By the way: As you can see in the previous steps MADRIX provides two possibilities to set Group Presets.

One option is the usage of the Set button and the second option offers the context menu which will be visible

with a right click.
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As last modification of this tutorial we have to change the Fade Time after activating a Group Preset to 3

seconds.

That means we simply need to set the Group Preset Fade Time below the Preset buttons to 3.
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0

.

If we now activate a Group Preset for example Preset 1 by clicking the desired Preset button, the stored

dimmer values will be activated with a 3 second fade.

Note: The visual result of dimming a Fixture Group will be only displayed in the Main Output Preview.

Congratulations! You have successfully learned how to work with Group Presets in MADRIX 5.
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2.4.3 Group Control Using Group Value Chaser

This tutorial shows you how to use the Group Value Chaser in MADRIX 5.

Date: 06/2021

MADRIX Version: 5.4b (Created with)

Corresponding Video Tutorial: »Using the Group Value Chaser

Note:

In this tutorial we will work with the result of the tutorial »Layer Mapping With Fixture Groups.

Task: 

We want to create a Group Value Chaser which should be stored in Group Preset 1. We also want to create a

second Group Preset which will stop the Group Value Chaser and sets the Fixture Groups to value 255 .

The Group Value Chaser should fade the dimmer values between 0 and 255 in a kind of even odd mode.

Furthermore the Fade Type of the Chaser steps should be changed from Linear to Ease Out Bounce, the Fade

Time set to 2 seconds and the Wait Time to 0 seconds.

1

.

The view of MADRIX is already set to Group Control. If you don't know how to activate the Group Control

view, please have a look at the tutorials: »Group Control For Live Control.

https://www.youtube.com/watch?v=p4SsA_pKZmo&list=PLJnczzTsD1-J1XkQB_Wv2MniYRCFZEYoN&index=42
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2

.

In this step we want to open the Group Value Chaser window. We perform a right click at the Chaser

button and select Edit in the context menu.

By the way: You will find the Group Value Chaser button at the top right side of the Group Control view.
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.

The Group Value Chaser  window opens and we can start to edit the dimmer values of the groups and add

the steps.



[Part B] MADRIX Effects

//410www.madrix.com

MADRIX 5 Tutorials Version 1.0

4

.

In the first step we set the value for the PAR Fixture group to 0 and click the + button at the Group Value

Chaser window to add this setting.
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5

.

For the second step of the Group Value Chaser we change the value for the PAR Fixture Group to 255 and

the value for the Bar Fixture Group to 0. To add these setting to a new Group Value Chaser step we click

the + button in the Group Value Chaser window.
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6

.

In this step we want to modify the settings for Fade Type, Fade Time and Wait Time of the Group Value

Chaser as requested in our task. 

When we have a look at the task we can figure out the settings for all steps should be the same. The Fade

Type should be set to Ease Out Bounce, the Fade Time to 2 seconds and the Wait Time to 0 seconds.

That means we can select both Chaser steps by pressing and holding the [Shift] key on the keyboard and

selecting the first and second chaser step with a click. 

After both steps are selected we want to change the Fade Type first. Therefor we perform a right click in the

Fade Type column for one of the steps and select Ease Out Bounce in the context menu. 

The two Chaser steps are still selected and we can change the settings for the Fade Time and Wait Time.

To modify the timing we perform a right click in the Fade Time column at one of the entries and enter the

value 2. To accept the values for both steps we press [Enter].

To modify the Wait Time value we perform a right click again, change the value to 0 and accept it with

[Enter].

Please note: If you don't know how to modify values of the Chaser steps please have a look at the tutorial:

»Effect Parameter Chaser For Effect Settings.
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.

When we now start to play back the Group Value Chaser, we can see the result of the created chaser.

Always one Fixture Group will be faded out and one will be faded in.

Note: The visual result of dimming a Fixture Group will be only displayed in the Main Output Preview.
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8

.

We want to save the Group Value Chaser as Group Preset 1. Therefore we change the Group Preset

Description to Even Odd and click the Set button.

If you don't know how to save a Group Preset please have a look at the tutorial: »Group Control Using

Presets.

By the way: With the help of Group Presets you can save several Group Value Chasers.
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9

.

At the moment the Group Value Chaser is running all the time. To stop it we can open the Group Value

Chaser window or we click the Group Value Chaser button. 

After the button was clicked the Group Value Chaser stops playing and the button will be illuminated in

blue.
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1

0

.

According to our task we have to create a second Group Preset which should set the Fixture Group values

to 255. 

Of course we can change the values for all Fixture Groups manually or we click the Defaults button to set

the values of all Fixture Groups to the default value which is 255 (if it wasn't modified in the Patch Editor).
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1

1

.

Before we save the second Group Preset we also have to clear the stopped Group Value Chaser.

Otherwise the current Group Value Chaser will be also saved in the desired Group Preset. To clear the

current Group Value Chaser we perform a right click at the Chaser button and select Clear in the context

menu.

Note: The Group Value Chaser in Group Preset 1 won't be deleted.



[Part B] MADRIX Effects

//418www.madrix.com

MADRIX 5 Tutorials Version 1.0

1

2

.

In the last step we want to add the current settings to to a second Group Preset. We call it Full ON and click

the Set button again.

If we now activate the Group Preset 1, the previously created Group Value Chaser will be played and if we

activate Group Preset 2, the Fixture Group values will be set to 255.

Congratulations! You have successfully learned how to work with the Group Value Chaser in MADRIX 5.
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2.5 Working With Global Colors

2.5.1 Adding Global Colors

This tutorial shows you how to add Global Colors in MADRIX 5.

Date: 07/2023

MADRIX Version: 5.6 (Created with)

Corresponding Video Tutorial: »Adding Global Colors

Note:

The result of this tutorial will be used in the tutorial »Creating Global Color Lists

Task: 

We have to define 4 different colors as Global Colors. Therefor we can use different ways to add these colors. 

Option 1: Adding a color at the Global Colors View.

Option 2: Adding a Global Color directly from the color definition of a MADRIX Effect.

The 4 colors are:

Red

Re

d

Gre

en

Blue

25

5

0 0

Blue

Re

d

Gre

en

Blue

0 0 255

Sunrise

Orange

Re

d

Gre

en

Blue

https://youtu.be/hQKg2z4lKhs
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25

1

165 90

Sunset

Purple

Re

d

Gre

en

Blue

12

9

29 94

1

.

To work with the Global Colors we need to change the view in MADRIX to Colors. 

With the help of the View Selection it is very easy to change the view to the desired one.
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2

.
At the Colors view we can start adding a new Global Color with the help of the + Button on the bottom of

the right list. 

3

.

After clicking the + Button the first time a new color in White will be added and we can start to modify this

color.
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According to our task the first color should be Red. Therefor we can use the Color Picker to select the

desired color. 

To open the Color Picker simply click and hold the left mouse button down at the color field and navigate to

Red. As soon as the Color Picker is over the red color release the mouse button.

5

.

The first color is now modified to red and we can change the Description also to Red. To change the

Description please perform a double click at the Description field of the desired entry and write the text.
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.

Now we can add the next color by clicking the + Button again.

7

.
The second color should be changed to Blue and the Description should be Blue of course. 



[Part B] MADRIX Effects

//424www.madrix.com

MADRIX 5 Tutorials Version 1.0

8

.

According to our task the third color should be the Sunset Orange with the values R: 251, G: 165, B: 90. To

change the value of a RGB color simply perform a double click at the desired column and type-in the desired

value with the keyboard.

9

.

The Description of the third Global Color should be changed to Sunrise Orange.
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0

.

Now we want to add the fourth color at the Global Colors list. But in this step we want to use the Layers

view of the MADRIX user interface. So please change the view back to the default view Layers.

We are defining the color according to our task at the SCE Color effect. The values are R: 129, G: 29, B:

94.

1

1

.

To convert this local defined color to a Global Color we perform a right click at the color field and select

Make Global in the context menu.
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1

2

.

A number according to the Global Color ID is now visible at the color field and indicates the usage of a

Global Color in this effect.

1

3

.

As last step we are changing the view again to Color and we set the Description to Sunset Purple for the

forth color.

Congratulations! You have successfully learned how to create a add Global Colors in MADRIX 5.
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2.5.2 Creating Global Color Lists

In this tutorial you can learn how to create Global Color Lists in MADRIX 5.

Date: 07/2023

MADRIX Version: 5.6 (Created with)

Corresponding Video Tutorial: »Creating Global Color Lists

Note:

In this tutorial we will work with the result of the tutorial »Adding Global Colors.

Furthermore the results of this tutorial will be used in the tutorials: »Using Global Colors And Color Lists and

»Modify Global Colors And Color Lists.

Task: 

Two Color Lists should be added. 

List 1 should contain the already defined Global Colors Red and Blue plus a local color Green. To find this List

later again the Description should be set to RBG.

List 2 should be displayed as a Gradient with the Global colors Sunrise Orange and Sunset Purple. The List

should be called Orange-Purple.

https://youtu.be/yJhMEDm58Us
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1

.

We are at the Colors View of MADRIX 5. We already created 4 different Global Colors in the tutorial:

»Adding Global Colors.

Now we want to add the first Global Color List by clicking the + Button at the bottom left corner.

2

.
A new list with one color will be added.
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3
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According to our task the first color of this list should be the globally defined Red color. So we click the color

field and select the Red color with the number 1 which you can find on the bottom of the Color Picker.

Note: Global Colors will include a number in the color field and the description will displayed in the middle of

the Color Ref.

4

.

The global color with ID 1 is now assigned as first color of the Global Color List. And we want to add the

second color which should be the globally defined color Blue. Of course we can add this color as we did

before by clicking the + button. 

But there is another way by using Drag & Drop. Therefor navigate with the mouse to the ID column of the

Blue color entry, click and hold the left mouse button and now move the mouse to the Global Color List.
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5

.

At the Global Color List definition release the mouse button.

6

.

Now the second color has been added to the list.

7

.
In this step we want to add an additional so called Local Color to this Global Color List. Therefor we click

the + button at the color configuration of the Color Lists again and change the color to Green.
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8

.
It is possible to create a Global Color List with Global Colors and also Local Colors. 

· Global Colors are always displayed with the associated Global Color ID.

· Local Colors won't display an ID.

· If a Global Color will be changed, all assigned instances will be changed, too.

9

.

The Description of this Global Color List should be changed to RBG. Therefor we perform a double click at

the Description column of the Global Color List entry. To accept the input simply press [Enter].
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0

.

In this step we will start to create the second Global Color List of this tutorial. 

We perform a click at the +button at the Global Color List section and we also change the first color from

white to Sunrise Orange. That means color ID 3 at the Color Picker.

1

1

.

Now we add the second color of this list via clicking the + button and the color list section and we have to

change it to color ID 4 according to our task.

1

2

.

We want to change the representation of the Color List into a Gradient. Therefor we have to click the

representation switch on the top right corner of the Global Color Lists section
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1

3

.

Now the view of this Color List entry is changed and you will be able to modify the colors also at this view.

As last step for this tutorial we want to change the Description of the second Global Color List entry to

Orange-Purple.

1

4

.

To accept the name please press [Enter] again.

Congratulations! You have successfully learned how to create Global Color Lists in MADRIX 5.
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2.5.3 Using Global Colors And Color Lists

In this tutorial you can learn how to work with already created  Global Colors and Global Color Lists in MADRIX 5.

Date: 07/2023

MADRIX Version: 5.6 (Created with)

Corresponding Video Tutorial: »Using Global Colors And Color Lists

Note:

In this tutorial we will work with the result of the tutorial »Creating Global Color Lists.

If you don't know how to work with Layers in MADRIX, it is recommended to have a look at the following tutorial:

»Add And Rename Layers.

If you are not familiar how to select he MADRIX effect please have a look at the MADRIX manual: »MADRIX

Effects.

Task: 

We have to assign the already created Global Colors and Color Lists to some MADRIX effects.

At Storage 1 Place 1 a SCE Color and a SCE Wave / Radial effect is assigned. The SCE Color layer should work

with Global Color: 3 (Sunrise Orange) and the SCE Wave/Radial layer should work with Global Color: 2

(Blue).

And at Storage 2 Place 1 a SCE Gradient and a SCE Metaballs effect is assigned. The SCE Gradient layer should

work with the Global Color List: 2 (Orange-Purple) and the SCE Metaballs layer should work with the Global

Color List: 1 (RGB).

All other parameters of the different effect layers are default.

https://youtu.be/6EHIMgbl9Cw
https://help.madrix.com/m5/html/madrix/index.html?hidd_effects_link.html
https://help.madrix.com/m5/html/madrix/index.html?hidd_effects_link.html
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1

.

The effects at Storage 1 Place 1 and Storage 2 Place 1 are already created. That means at Storage 1 Place 1 a

SCE Color is assigned to layer 1 and at layer 2 a SCE Wave / Radial is assigned.

At layer 1 of Storage 2 Place 1 a SCE Gradient and at layer 2 a SCE Metaballs are assigned.

All the effect are working with the default parameters.
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2

.
Now we will start. As first step we are changing the color of the SCE Color layer to the Global Color 3.

Therefor we select the SCE Color layer at the programming view (the layer name is now illuminated in

Green). To assign the Global Color 3 we navigate to the color filed, perform a click on it, hold the mouse

button and move the mouse to the color 3 at the bottom color line below the Color Picker.
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.

In this step we activate the SCE Wave / Radial layer of Storage 1 Place 1. In this step we are performing a

right click at the Color Field and select Global Selection > 2: Blue from the context menu according to our

task.

Alternatively you can select the color as explained at Step 2.
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4

.

Now we have assigned the Global Colors for Storage 1 Place 1. 

When we have a closer look at the color field we can see a number in it. This number indicates the desired

Global Color is used.
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.

Now we want to have a look at Storage 2 Place 1. For the background layer (Gradient layer) we have to

assign Global Color List 2 (Orange-Purple).

Therefor we select the Gradient layer. Now we perform a right click at the Gradient Control and select

Global Selection > 2: Orange-Purple.
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6

.

The Global Color List is now assigned to this gradient. If a Global Color List is assigned and the

Description of it is set, you we can find it as description in the Gradient Control. Otherwise only the Global

Color List ID will be visible. 
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7

.
Now we activate the Metaballs layer of this effect.
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8

.
At the Metaballs layer we open the Color Table with a click at the Colors button on top of the effect

settings. Now we can assign the required Global Color List: 1 (RGB) 

At the Color Table we click the Global Colors button and select Global Selection > 1: RGB from the

context menu.
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.

As soon as a Global Color List is selected we can find the Global Color ID and Description on the button.

In the Color Table we can find all colors of this Global Color List. If the colors are Global Colors, the

Global Color ID will be displayed at the color field and the associated description can be found at the

Description column of every entry.
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0

.

Now we have assigned all Global Colors and Global Color Lists according to our task.

Congratulations! You have successfully learned how to work with Global Colors and Global Color Lists in MADRIX

5.
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2.5.4 Modify Global Colors And Color Lists

· This tutorial shows you how to Global Colors and Color Global Color Lists in MADRIX 5.

Date: 07/2023

MADRIX Version: 5.6 (Created with)

Corresponding Video Tutorial: »Modify Global Colors And Color Lists

Note:

In this tutorial we will work with the result of the tutorial »Using Global Colors And Color Lists.

Task: 

We want to modify the Global Color 1 plus 2 and create a new Global Color by modifying the Global Color 3.

Thus we are also modifying the first Global Color List.

· Global Color 1 should be changed from Red to Yellow.

· The second color of the Global Color List RBG should be changed from Blue to Purple and updated as Global

Color.

· The used Global Color 3 at the SCE Color Effect layer should be changed to Green and we would like to add

this new color as Global Color..

https://youtu.be/TVXfWtKUahE
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.

The required setup of the Tutorial »Using Global Colors And Color Lists is already loaded and the Colors view is

activated.
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2

.
Let us start to change the first color from Red to Yellow. We are simply using the color picker and moving

the mouse from Red to the Yellow color.

As soon as the color is changed all Effect Layers and colors of the Global Color Lists which are using this

Global Color are updated.
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3

.

Now we are selecting the second color of the Global Color List RBG. Therefor the Global Color List RBG

needs to be selected on the left side of the Colors view and the second color of this list (Blue) needs to be

selected and we change it to Purple like explained in Step 2.

As soon as this Global Color in the color list was changed a * will be displayed behind the number of the

Global Color. This indicates a Global Color is modified.

4

.

If we perform a right click at the color field a context menu opens. According to our task we have to update

this modified Global Color we select Update Globally.
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.

The second color of our list Global Colors is now changed from Blue to Purple. And thus all effects which have

assigned this Global Color are also updated automatically.

6

.

In this step we want to change the Color of the SCE Color layer which is at Storage 1, Place 1 from

Orange to Green. 

So we are changing the the MADRIX view to the Layers view and activating Layer 1 of Storage 1, Place 1.
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.
According to our task we change the color to Green by using the Color Picker. 

As soon as we have modified the color the * will be displayed.
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.
Now we want to add this modified color as a new color to the list of Global Colors. Therefor we perform

again a right click at the color field and select Make Global.

9

.

When we now change the view again to Colors we can figure out a new color was added to the list.

Congratulations! You have successfully learned how to modify Global Colors and Global Color Lists in MADRIX 5.
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3 Automated Playback

3.1 Timelines

In this tutorials you will learn more about the usage of the MADRIX Timelines.
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3.1.1 How To Create Timelines

This tutorial shows you how to create a timeline with the help of the Timeline Editor in MADRIX 5.

Date: 06/2022

MADRIX Version: 5.5 (Created with)

Corresponding Video Tutorial: »Create A Timeline

Note:

The result of this tutorial will be used in the tutorial »Modify Audio Files

Task: 

In this tutorial we will create a timeline which should be called First Song and the content of an already created

MADRIX setup. The timeline should playback a desired audio file and we will add 3 cues to the timeline.

As setup we will load the Matthias-2D.msz sample setup which you will find in the MADRIX sample setups folder

under Documents > Setups > MADRIX5 Samples.

1

.

To load the setup we navigate to File > Open Setup...

https://www.youtube.com/watch?v=OYAzBCe1ZJM
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.
Please navigate to the folder: Documents > Setups > MADRIX5 Samples and select the file Matthias-

2D.msz
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3

.

We will load all components. So we can click OK at the Open Setup Options.

4

.

After the setup was loaded we change the view to Timelines. Therefor we select the Layer Control button

and click Timelines in the context menu.

[Keyboard shortcut: F10]
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5

.

The Timeline Editor opens and we can add a new Timeline with a click at the + button.
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6

.

We rename the added timeline via a double-click at the column Name. In this tutorial we call the timeline

First Song and press Enter.
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7

.
In this step we will load a desired Audio file. With a click at the + button at the Audio Segments section the

open audio file window appears and you can select your desired audio file. 
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8

.

Once you opened an audio file you will see the analyzed wave form of the file.

9

.

Now we can start playing back the audio file via a click at the Play/Pause button at the Playback section.
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1

0

.

We are able to add Markers during the playback of a song. To add a Marker simply press the M at your

keyboard. In this tutorial we will add to markers at conspicuous points of the track.

Note: 

· Markers can help you to place cues at your desired position. 

· You can add as many markers as you want.
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1

1

.

Now we move the playhead of the timeline to position 00:00:00:00 via a click at the timeline. 

To add a Cue Segment we click the + button at the Cue Segment section.

1

2

.

With a click at the + button a Cue Segment which is assigned at Storage 1 Place 1 will be added but you can

change this assignment at the Cue section
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1

3

.

Simply select the desired Storage respectively Place to assign another Storage Place.

1

4

.

It is also possible to add a new Cue Segment via Drag and Drop. Therefor you have to perform a long-click

(click and hold the mouse down for 2 seconds) at a desired Storage Place. Now you can move the still

clicked mouse to the Cue Segment section of the Timeline Editor and the dragged Storage Place will snap

to the playhead or a marker and you can drop it.
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Congratulations! You have successfully learned how create a Timeline in MADRIX 5.
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3.1.2 Modify Audio Files

This tutorial shows you how to use modify audio files at the Timeline Editor in MADRIX 5.

Date: 06/2022

MADRIX Version: 5.5 (Created with)

Corresponding Video Tutorial: »Modify An Audio File In The Timeline Editor

Note:

· In this tutorial we will work with the created Timeline of the tutorial: »How To Create Timelines

· The result of this tutorial will be used in the tutorial: »Modify Cue Segments

Task: 

In this tutorial we will trim the audio file to 40 seconds, modify the audio value to fade-in and fade-out the audio

file. Furthermore we will change the value of it from 100 percent to 80 percent at a desired point.

1

.

In the first step we want to trim the audio file. Therefor simply navigate with the mouse to the end of the

audio track. The mouse pointer will change to a double arrow. Now please click and hold the left mouse

button down and move the mouse.

https://www.youtube.com/watch?v=nWj1ELh5brY
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2

.

According to our task we have we move the mouse to second 40 and we can release the mouse button.
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3

.

Now we want to modify the audio volume of the track. Therefor perform a click  at a desired point at

waveform of the track and a new level adjustment point will be inserted. 

In this example we will add one point at level 100 percent and approximately 1 second after the start. 

Note: You can simply move the point via drag and drop
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4

.

In this step we will add a second level adjustment point at the beginning of the track with the value 0.

With the help of these two points we have created a kind of fade-in effect for the audio file.
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5

.

According to our task we want to add another level adjustment point at a desired position and change the

audio volume to 80. Therefor we click again at the waveform at the Timeline Editor and we want to modify

the value by typing the value 80 at the Settings section of the Timeline Editor.
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6

.

Like the fade-in with 2 level adjustment points we want to create a fade-out. To insert a level adjustment

point for the beginning of the fade-out we perform a click at second 39 in the audio track and ensure the

volume is still set to 80. To double check please have a look at the Settings section.

We want to add a last level adjustment point at the end of the trimmed track and we change the value to 0.

Now we have created a kind of fade-out effect for the audio track at the end of track.

Note: In the Settings section you will always be able to modify the selected object.

Congratulations! You have successfully learned how edit an audio track with the help of the Timeline Editor in

MADRIX 5.
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3.1.3 Modify Cue Segments

In this tutorial you will learn how to modify cue segments of the timeline in MADRIX 5.

Date: 06/2022

MADRIX Version: 5.5 (Created with)

Corresponding Video Tutorial: »Modify Cue Segments In The Timeline Editor

Note:

In this tutorial we will work with the result of the tutorial: »Modify Audio Files

Task: 

As task we have to modify the timeline in the following way:

· Trim the timeline to 40 seconds playback time

· Add a Crossfade between Cue Segment 1 and 2 of 1 second

· Add a Whitefade between Cue Segment 2 and 3 of 1 second 15 frames

· Fade-in the Layer Opacity of Layer 1 and Layer 2 of Cue Segment 2 with different values

1

.

According to your task we want to trim the length of the timeline to 40 seconds. Therefor we navigate to the

Timeline Duration settings and type 00:00:40:00.

https://www.youtube.com/watch?v=kLLkxjADfjU
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2

.
After pressing Enter on the keyboard the duration of the timeline will be set to 40 seconds.

3

.

In this step we want to modify Fade Time between Cue Segment 1 and Cue Segment 2. To modify it

simply select the first Cue Segment and now you can grab the top corner of it and move it to the left.

Furthermore you can double check and set the fade out time with the help of the Settings section.

According to our task we have to set a fade time of 1 second.
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4

.

Now we want to modify the Layer Opacity of the second Cue Segment. We select the second one and

perform a right click at the Cue Segment. In the context menu we select Edit Layer Opacity. 
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5

.

By default the modification of the Layer Opacity of Layer 1 is selected. According to the task we have to

create a fade-in for Layer 1 and Layer 2. 

So we add 2 layer opacity adjust points. One point should be set at position 0 with value 0 of the second Cue

Segment and the second one should be placed at a desired position. In this example it will be placed at 1

second 1 frame with the value 255.

Note:

· To add a layer opacity adjust point simply click at the selected Cue segment. If you grab a point you can

change the time and the opacity value via your mouse.

· You will be able to modify a selected layer opacity adjust point with the help of the Settings section to set

concrete values for the timing and layer opacity.
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6

.

In this step we want to start the modification of the Layer Opacity for the second Layer. Therefor we click

the Layer button at the Settings section and select 2: Plasma.

7

.
We want to add again 2 layer opacity adjust points. This layer should faded in with a delay. So we add one

point at a desired position with value 0 and the second one should be placed at a desired position behind

position of the first one with the value 180. 

As you have learned in step 5 you are able to modify the values and timing in the Settings section.
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8

.

After all Layer Opacity settings are done we can close the settings for it. Therefor we click the Close button at

the Settings section.

9

.

In this step we want to change the fade type for the fade between Cue Segment 2 and 3 to White Fade.

To perform this modification we have to select the third Cue Segment. Now we click the Fade-In type

button and select WF.
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1

0

.

According to our task we have to change the Fade-In time to 00:00:01:15.

1

1

.

After pressing Enter the Fade-In Time will be accepted and we can see the modification at the Cue

Segment.

Congratulations! You have successfully learned how to modify Cue Segments with the help of the Timeline Editor

in MADRIX 5.
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4 Imprint And Copyright

Company And Address

inoage GmbH

Wiener Straße 56

01219 Dresden

Germany

Managing Directors: Christian Hertel, Sebastian Pinzer, Sebastian Wissmann

Phone: +49 351 862 6869 0

Fax: +49 351 862 6869 68

Web: www.madrix.com

E-mail: info@madrix.com

Copyright

Copyright (c) 2001 - 2023 inoage GmbH. All rights reserved.

MADRIX is a trademark of inoage GmbH. 

All other company names and/or product names are trademarks and/or entered trademarks of their respective

holders. The product might not always be conforming to the presentation, features, and performances. Technical

data can differ slightly, depending on the operating system and the chosen hardware. 

We withhold the option of changes without notification. inoage GmbH does not give any guaranty for function

capability for a certain purpose, the marked ability or other features of the product. No other guaranty claims, on

legal or other terms, can be enforced. 

http://www.madrix.com
mailto:info@madrix.com
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Under no circumstances does inoage GmbH take on the responsibility for liabilities for faults for losses in sales

volume or profits, that occur through the usage of the product, through the serviceability, through abuse,

happenings, circumstances or actions, that we have no influence on. No matter if the damages were caused by the

holder of the product or a third person.

Credits

§ Microsoft, Windows are U.S. registered trademarks of Microsoft Corporation.

§ Art-Net™ - Designed by and Copyright Artistic Licence Holdings Ltd.

§ ASIO is a trademark and software of Steinberg Media Technologies GmbH.

§ Intel is a trademark of Intel Corporation in the U.S. and/or other countries.

§ NVIDIA is a trademark and/or registered trademark of NVIDIA Corporation in the U.S. and/or other countries.

§ Other product and company names, terms, or [trade] marks are the property of their respective holders.
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